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4 Resumen 

Con la realización de la presente investigación se identificó la vulnerabilidad 

de la cuenca hidrográfica Ilo - Moquegua para afrontar el cambio climático en los 

diferentes escenarios propuestos. Para ello se utilizaron datos de precipitación, 

temperatura, caudales pertenecientes a la cuenca hidrográfica, luego se realizó el 

análisis las dimensiones biofísicas, políticos institucionales, económico productivas 

y socio culturales, así como sus indicadores, todo ello con el objetivo de hallar la 

vulnerabilidad de la cuenca y analizar esta en diferentes escenarios del cambio 

climático siendo: el presente, niño moderado, niña moderada, cada uno de ellos en 

condiciones de baja y alta capacidad adaptativa. Primero se realizó la identificación 

de las condiciones actuales de la cuenca hidrográfica Ilo - Moquegua para luego 

proceder con la recolección y procesamiento de datos obtenidos de los últimos 30 

años mediante las plataformas de NASA POWER y SENAMHI, de esta forma se 

obtuvo los promedios de datos meteorológicos, además se obtuvo el caudal de la 

cuenca hidrográfica Ilo - Moquegua utilizando el software HEC-HMS. Finalmente, 

se procedió a realizar el análisis de vulnerabilidad encontrando los datos de los 

indicadores propuestos en la metodología y planteados en los escenarios 

escogidos encontrándose que la vulnerabilidad de la cuenca hidrográfica Ilo - 

Moquegua es de nivel medio - alto, considerando el escenario de niña moderada 

BCA, para lo que se planteó una propuesta para poder afrontar la incidencia de este 

escenario de cambio climático. 

Palabras clave: Vulnerabilidad, Cuenca, Cambio climático  
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5 Abstract 

With the realization of this research, the vulnerability of the Ilo - Moquegua 

watershed was identified to face climate change in the different proposed scenarios. 

For this, data on precipitation, temperature, flows belonging to the hydrographic 

basin were used, then the biophysical, institutional political, economic, productive 

and socio-cultural dimensions were analyzed, as well as their indicators, all with the 

aim of finding the vulnerability of the basin and analyze it in different scenarios of 

climate change being: the present, moderate boy, moderate girl, each one of them 

in conditions of low and high adaptive capacity. First, the identification of the current 

conditions of the Ilo - Moquegua watershed was carried out and then proceed with 

the collection and processing of data obtained from the last 30 years through the 

NASA POWER and SENAMHI platforms, in this way the data averages were 

obtained In addition, the flow of the Ilo - Moquegua watershed was obtained using 

the HEC-HMS software. Finally, the vulnerability analysis was carried out, finding 

the data of the indicators proposed in the methodology and raised in the chosen 

scenarios, finding that the vulnerability of the Ilo-Moquegua watershed is of medium-

high level, considering the moderate-girl BCA scenario, for which a proposal was 

made to be able to face the incidence of this climate change scenario. 

Keywords: Vulnerability, Watershed, Climate Change   



1 

 

I. INTRODUCCIÓN 

El análisis de la vulnerabilidad de una cuenca hidrográfica hoy en día se considera 

de gran relevancia ya que una cuenca es tomada como una unidad de diagnóstico 

para el manejo y planificación del recurso hídrico, al hallar la vulnerabilidad de la 

cuenca se puede identificar el grado de amenazas que existen. Por otra parte, antes 

de las actividades extractivas antropogénicas, los sistemas hidrográficos se 

encontraban viables, funcionales y en estado moderado es por ello que las 

interferencias se deben realizar de una manera más sostenible y racional, 

contemplando la preservación del equilibrio y los recursos naturales de la cuenca, 

con la finalidad de proteger y salvaguardar las cuencas hidrográficas (Moreira, et 

al. 2019, p. 71). 

Castro, et al. (2018) definen al calentamiento global como “El incremento de 

forma gradual en la temperatura en la corteza terrestre como consecuencia del 

forzamiento radiativo provocado por causas antropogénicas, principalmente 

emisiones” (p.61). 

En relación a esto, sus efectos tienen un impacto de una preocupante 

magnitud, siendo una de las variables principales la hidrológica, que engloba a las 

precipitaciones, y al ser estas el fundamental elemento de balance temporal y 

espacial de los recursos hídricos; su estudio de modelo integral de la cuenca 

hidrográfica es de vital importancia (UNESCO, y CODIA, 2019, p.22). 

Así también Castro, et al. (2018) agregan que actualmente el mundo se 

encuentra en una fase de cambios continuos, que en su mayoría rebasan nuestra 

capacidad adaptativa, estos cambios provocan el incremento de demanda en 

bienes y servicios, por lo que los recursos naturales sufren presión, como 

consecuencia de ello se producen los GEI, lo que provoca el fenómeno conocido 

como “calentamiento global” (p. 61). 

Del mismo modo, el desarrollo de nuestro país poco a poco genera una 

mayor demanda del recurso hídrico para así satisfacer las demandas de la 

creciente población y del entorno que la rodea, lo que trae consigo diferentes 

variaciones en los sistemas acuáticos, alteraciones del recurso hídrico entre otros. 



2 

 

Con el aumento de la demanda el uso de este recurso hídrico es abrupto lo que 

origina una serie de posibles amenazas para el desarrollo sostenible de este 

recurso, el medio ambiente que lo rodea, la salud, seguridad alimentaria, desarrollo 

industrial y el desarrollo de los ecosistemas colindantes; estas amenazas además 

de las variaciones climáticas de la zona de estudio podrían alterar esta 

sostenibilidad. De la misma manera, al hacer uso del agua para fines domésticos e 

industriales, la demanda del recurso hídrico cada vez es mayor a nivel mundial, 

nacional y local (UNESCO, 2019, p.4). 

Por otro lado, Perú se encuentra en el tercer lugar en el mundo dentro de los 

países con mayor vulnerabilidad frente a los efectos del CC, luego de Honduras y 

Bangladesh, y se estima que nuestro país dentro de los próximos 40 años solo 

poseerá el 60% del agua potable que tiene actualmente, lo que causará grave 

escasez (HUERTA, 2020). 

Además, Castro, et al. (2018) señalan que, en los países tercermundistas, 

las asociaciones de gestión eficaz de las cuencas todavía se encuentran 

emergentes, sin embargo, en países desarrollados el manejo de cuencas 

hidrográficas tiene un efecto muy positivo sobre las consecuencias del cambio 

climático (p. 55). 

Del mismo modo, Castro, et al (2018) argumentan que las zonas 

urbanizadas dependen directamente de una CH, el problema radica en que la 

expansión urbana contribuye enormemente a la degradación de la cuenca debido 

al cambio de uso de suelo, aumentando la vulnerabilidad de esta, un manejo 

sustentable entre los usuarios que se encuentran tanto arriba como debajo de la 

cuenca reduce las vulnerabilidades e incrementa la capacidad adaptativa de la 

cuenca para lidiar con potenciales desastres (p.58). 

Al respecto, la cuenca hidrográfica de Moquegua es demasiado irregular y 

escasa, es por ello que se construye el embalse Pasto Grande en la parte alta del 

río Vizcachas, en la cuenca del río Tambo, para que sus aguas sean derivadas al 

río Moquegua y sean usadas para satisfacer las necesidades básicas de la 

creciente población que utiliza el recurso hídrico en la cuenca (ANA, 2016, p.4).  
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Además de acuerdo a (INGEMMET, 2019, p. 14) la cuenca Ilo Moquegua no 

cuenta aún con un manejo integral del uso del agua, es decir que la gestión de 

recursos hídricos superficiales y subterráneos no existe en forma conjunta por lo 

que esto produce un uso irracional y sin control de la cuenca, entendiéndose 

entonces que esta cuenca se encuentra vulnerable ante los efectos de la variación 

climática. 

Por consecuente, el presente trabajo tiene como objetivo general: 

Determinar si la gestión de la vulnerabilidad de la cuenca hidrográfica Ilo - 

Moquegua reduce los efectos de diferentes escenarios del cambio climático. Los 

objetivos específicos son: 

▪ OE1: Identificar la situación actual de la cuenca hidrográfica Ilo - 

Moquegua que incide frente a diferentes escenarios del cambio climático. 

▪ OE2: Analizar los datos obtenidos de temperatura, precipitación y caudal 

de un periodo de 30 años que inciden frente a diferentes escenarios del 

cambio climático. 

▪ OE 3: Establecer las dimensiones en la cuenca hidrográfica Ilo – 

Moquegua que inciden frente a diferentes escenarios del cambio 

climático. 

▪ OE 4: Evaluar las estrategias en la cuenca hidrográfica Ilo - Moquegua 

que inciden frente a diferentes escenarios del cambio climático. 

Para el problema general se planteó: ¿Cómo la gestión de la vulnerabilidad 

de la cuenca hidrográfica Ilo - Moquegua incide frente a diferentes escenarios del 

cambio climático? Los problemas específicos de la investigación fueron los 

siguientes: 

▪ PE1: ¿Cuál es la situación actual de la cuenca hidrográfica Ilo - 

Moquegua que incide frente a diferentes escenarios del cambio 

climático? 
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▪ PE 2: ¿Cómo los datos obtenidos de temperatura, precipitación y caudal 

de un periodo de 30 años incide frente a diferentes escenarios del cambio 

climático? 

▪ PE 3: ¿De qué manera las dimensiones de la cuenca hidrográfica Ilo - 

Moquegua inciden frente a diferentes escenarios del cambio climático? 

▪ PE 4: ¿Cuáles son las estrategias en la cuenca hidrográfica Ilo - 

Moquegua que inciden frente a diferentes escenarios del cambio 

climático?  

Como hipótesis general se tiene que: La gestión de la vulnerabilidad de la 

cuenca hidrográfica Ilo-Moquegua evidencia la reducción de los efectos de 

diferentes escenarios del cambio climático. Las hipótesis específicas de la 

investigación fueron las siguientes: 

● HE 1: La situación actual de la cuenca hidrográfica del rio Moquegua 

incide frente a diferentes escenarios del cambio climático. 

● HE 2: Los datos obtenidos de temperatura, precipitación y caudal de un 

periodo de 30 años inciden frente a diferentes escenarios del cambio 

climático 

● HE 3: Las dimensiones en la cuenca hidrográfica Ilo - Moquegua inciden 

frente a diferentes escenarios del cambio climático. 

● HE 4: Las estrategias en la cuenca hidrográfica Ilo - Moquegua inciden 

frente a diferentes escenarios del cambio climático. 

La justificación teórica de la presente investigación fue describir los 

indicadores, niveles y características de la vulnerabilidad de la cuenca hidrográfica 

Ilo - Moquegua para lograr afrontar el curso del cambio climático. La justificación 

metodológica fue que al aplicar la metodología propuesta en el trabajo se pudo 

delimitar las dimensiones de la cuenca y los indicadores y gracias a ello se puede 

plantear estrategias políticas y normas de responsabilidad compartida con la 
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finalidad de comprobar la vulnerabilidad de la cuenca frente al cambio climático 

(Valencia et al., 2016, p.3). 

La justificación social se basa en que la adecuada gestión de la cuenca 

hidrográfica permitirá obtener mejor satisfacción respecto a las demandas y 

necesidades que tiene la población aledaña a ella y también impulsar su capital 

social y humano, gracias al análisis de la vulnerabilidad de la cuenca hidrográfica 

Ilo - Moquegua se impulsan diferentes actividades como convenios comunitarios e 

intercomunitarios, mejoramiento de productos agrícolas, diagnósticos 

participativos, monitoreos de calidad de agua, talleres de capacitación entre otros, 

para lograr hacerle frente a los efectos del CC. Por ello la propuesta de estrategias 

se presenta como una opción viable para aprovechar al máximo los beneficios que 

la cuenca hidrográfica Ilo - Moquegua y lograr prever a la población del entorno 

local, municipal y/o nacional (Secretaría de Agricultura y Desarrollo Rural, 2020, 

párr. 6). 

La justificación económica es que al analizar si la cuenca hidrográfica Ilo - 

Moquegua es o no vulnerable se puede impulsar la inversión en la movilización de 

la inversión climática, proponiendo soluciones innovadoras de financiación 

combinada para el agua y el clima ante los diferentes escenarios de cambio 

climático, con bonos climáticos verdes y azules.  

Finalmente, la justificación ambiental en la presente investigación es que al 

haber presencia de cambios climáticos sin la adecuada prevención, estos ponen en 

peligro la sostenibilidad de los recursos ya que se disminuyen los suministros de la 

disposición de recursos hídricos o aumenta su demanda en la cuenca hidrográfica 

Ilo - Moquegua (Grupo de expertos de ONU – Agua sobre el Agua y Cambio 

Climático, 2020, p. 9).  
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II. MARCO TEÓRICO 

Las fuentes de los antecedentes de este trabajo fueron extraídas de las plataformas 

Scielo, ResearchGate y Scopus, además de la búsqueda en Google Académico 

para las tesis, con una antigüedad no menor de 5 años. Estos antecedentes 

proporcionan un marco referencial para la elaboración de la metodología del trabajo 

y son de fuentes internacionales y nacionales. 

(Esquinca, 2018) en su artículo de investigación titulado: “Una estrategia 

participativa de gestión del comité de cuenca del río Cahoacán para la adaptación 

al cambio climático con base en ecosistemas” tuvo como objetivo principal 

establecer estrategias participativas para la cuenca del río Cahoacán, y su 

adaptación al CC, este proyecto de gestión integrada se debió principalmente a la 

ocurrencia del huracán Stan ocurrido el 2005, esto tuvo como consecuencia la 

necesidad de reformular estrategias de contingencia en la cuenca además del 

fortalecimiento de gestión ante el cambio climático y tuvo una duración de 48 

meses, como resultado se obtuvo las siguientes estrategias para la cuenca, como 

fortalecer la gestión integrada a nivel de microcuencas con la participación 

comunitaria, desarrollar un programa de servicios ambientales hidrológicos de 

mitigación de desastres naturales en apoyo de la comunidad y fortalecimiento de 

las alianzas estratégicas, ampliar acciones municipales para el monitoreo y el 

saneamiento ambiental como principal vía para mejorar la calidad del agua, 

impulsar la economía amigable con el ambiente en la cuenca, fortalecer las 

instituciones que controlan las microcuencas, establecer un programa de carácter 

intermunicipal sobre la mitigación y adaptación al CC a través de la gestión del 

riesgo, propiciar el fortalecimiento de las instituciones que mantienen inversiones 

como el Comité de cuenca. Finalmente, como conclusión señala que la gestión 

participativa en las cuencas con un enfoque en cambio climático permite un mejor 

desempeño en estas, además de la inclusión de todos los actores de la misma ya 

que su apoyo es determinante para el futuro de la cuenca (p. 49-60). 

(Musseta, y otros, 2017) en su artículo de investigación titulado: 

Vulnerabilidad al cambio climático: Dificultades en el uso de indicadores de dos 

cuencas de Colombia y Argentina tuvo como objetivo aportar evidencia acerca del 
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uso de los indicadores para valorar la vulnerabilidad de dos cuencas hidrográficas 

a los efectos del CC, además de propiciar la refinación de las metodologías para la 

medición de la vulnerabilidad a través de la propuesta de indicadores, para este 

trabajo se usó dos cuencas tanto de Colombia como de Argentina, siendo la cuenca 

del Río Chinchiná y el Río Mendoza respectivamente, para ello los autores usaron 

las tres dimensiones establecidas por el IPCC para evaluar la vulnerabilidad en una 

cuenca hidrográfica y propusieron indicadores para evaluar estas tres dimensiones, 

que son, la sensibilidad, la capacidad adaptativa y la exposición, como resultados 

hallaron cada uno de los indicadores propuestos y elaboraron una propuesta para 

realizar un análisis cuantitativo de la vulnerabilidad de las cuencas estudiadas. 

Finalmente, como conclusión los autores señalan que es necesario brindar 

herramientas como esta para que los gobiernos tomen adecuadas decisiones 

políticas, ya que implican la redistribución justa de los recursos y la mejora del 

acceso a la tierra, la distribución del agua y la tecnología (p. 119-147). 

(Benegas, y otros, 2020) en su artículo de investigación titulado: 

Planificación basada en el servicio ecosistémico hídrico ante la vulnerabilidad al 

cambio climático en la región hidrográfica del estero Jaltepeque, El Salvador tuvo 

como objetivo principal analizar la vulnerabilidad de la población que se encarga 

del manejo de la cuenca baja del río Lempa o también conocida como la región 

hidrográfica del Estero Jaltepeque, para ello los autores analizaron la cuenca para 

mantener tres servicios ecosistémicos: Mitigación de inundaciones, manejo 

adecuado de la erosión para mejorar la calidad de agua y mejoramiento de la 

recarga de acuíferos, como resultado se obtuvo que la distribución de nuevas 

coberturas con las que se podría mantener estos tres servicios priorizados serán la 

agricultura a través de tres buenas prácticas, que son la plantación de contorno, 

uso de semillas mejoradas y conservación de suelos y aguas, el café fue la 

plantación escogida para ello, seguida de agricultura tropical mixta, como 

conclusión los autores indican que este manejo permite conservar los servicios 

ecosistémicos brindados por la cuenca a fin de reducir el impacto lo menos posible 

y sin afectar los ecosistemas frágiles los cuales son clave para la región (p. 355 – 

363). 
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(Huerta, 2020) en su tesis con grado de magíster titulada: Vulnerabilidad de 

la disponibilidad de los recursos hídricos en el Perú frente al cambio climático: 

Análisis probabilístico de Budyko tuvo como objetivo principal determinar la 

vulnerabilidad de los recursos hídricos del país con respecto al CC, para lograrlo el 

autor primeramente recopiló datos de temperatura, precipitación, 

evapotranspiración y caudales para la aplicación de Budyko probabilístico, 

demostrando la eficiencia de este método para la estimación del índice de 

evaporación además de caracterizar hidro climáticamente la cuenca, como 

conclusión se obtuvo que existe un incremento de la vulnerabilidad debido a 

cambios negativos en la precipitación, también se obtuvo que las cuencas 

pertenecientes de la vertiente del Amazonas serían las más susceptibles al CC, 

seguidas de las cuencas pertenecientes a la vertiente del pacífico y el Titicaca (p. 

1-116). 

(Escobar, y otros, 2020) en su tesis titulada: Medición de adaptación al 

cambio climático en la subcuenca del Rio Terán, Municipio de Yacopi, Cundimarca 

tuvo como objetivo principal formular medidas de adaptación al CC de la subcuenca 

ya indicada para ello los autores definieron el área de estudio y luego diseñaron el 

trabajo en tres fases: Recopilación y revisión de la información secundaria aplicable 

al CC en la sub cuenca, diagnóstico y caracterización de variables climáticas y 

diseño de las medidas de adaptación al cambio climático, como resultado se obtuvo 

que luego de la recopilación de datos climáticos de la cuenca y posterior 

comparación se obtuvo que los eventos de riesgo presentes en la sub cuenca del 

rio Teran son el movimiento en masa, la torrencialidad, los incendios forestales y 

las inundaciones y finalmente se propuso acciones contra el cambio climático y 

resultados esperados. Finalmente, como conclusión los autores obtuvieron que las 

medidas propuestas garantizarían un territorio más seguro y resiliente ante el 

cambio climático, sin embargo, es necesario fortalecer a las autoridades, ya que 

carecen de capacidad técnica, recursos financieros, así mismo fortalecer la cultura 

ambiental en las comunidades implicadas, principalmente de carácter agrícola (p. 

1-119). 

(Zabala, y otros, 2019) en su artículo de investigación titulado: “Capacidad 

adaptativa y vulnerabilidad de la cuenca del río Orotoy ante el cambio climático, a 
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partir del análisis de las variables de los medios de vida” tuvo como primer objetivo 

la determinación de las variables con mayor dominio en las unidades de análisis, 

estas son: Perfiles de actores, secciones de cuenca, marco urbano y rurales, de 

esta forma se relacionaron con capacidades adaptativas al cambio climático, para 

ello los autores recolectaron información durante el año 2016 para luego realizar el 

cálculo de las capacidades adaptativas y posteriormente el análisis documentario, 

se concluyó que las variables que influyen  en el análisis de vulnerabilidad de la 

cuenca con respecto a la capacidad adaptativa tienen que tener en cuenta varios 

tipos de enfoque, diferente de lo tradicional y que dependerán de un anticipado 

análisis de la cuenca, tanto ecológico como socioeconómico. 

(Valencia, y otros, 2016) en su artículo de investigación titulado: 

“Metodología para el análisis de vulnerabilidad en cuencas abastecedoras de agua 

ante la variabilidad climática” tiene como objetivo la propuesta de una metodología 

para poder analizar la vulnerabilidad de una cuenca, para ello los autores 

consideraron los siguientes componentes; Indicadores pertinentes, percepción, 

procedimientos matemáticos, saberes locales, identificación de problemática, 

instrumentos de planificación territorial, clima, esta metodología se aplicó a dos 

cuencas de Medellín, es decir, Popayán y Cajibío para ello los autores propusieron 

un rango de interpretación de la vulnerabilidad calculada mediante el hallazgo de 

los tres componentes del IPCC que son: Capacidad adaptativa, sensibilidad y 

exposición, estos hallados de acuerdo a indicadores propuestos, como resultado 

se obtuvieron las vulnerabilidades de las cuencas en mención y finalmente los 

autores concluyeron que la metodología propuesta es útil para analizar indicadores 

de diferentes dimensiones y que puede ser replicada en otros sistemas 

hidrográficos (p. 29-43). 

(Zhao & Wu, 2019) en su investigación titulada: Predicción sobre los 

impactos del cambio climático en los ciclos de acoplamiento agua – carbono en la 

cuenca hidrográfica de Loess Hilly-Gully tuvo como objetivo general la evaluación 

de los impactos futuros del CC en los ciclos de carbono y agua a través del uso de 

modelo hidro químico integrado (SWAT- DayCent) e investigar cuantitativamente 

los impactos del CC en el acoplamiento de los ciclos del agua y el carbono para la 

cuenca hidrográfica de Loess en China, para ello usó dos periodos futuros, de 2020-
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2049 (cerca de futuro, CF) y 2070-2099 (futuro lejano, FL), como resultados se 

obtuvo que para el periodo CF la precipitación anual disminuiría levemente de un 4 

a 11% y durante el periodo FL las temperaturas máximas y mínimas del aire 

aumentan significativamente, el caudal medio disminuiría hasta el 20.1% y la 

evapotranspiración permanece casi sin cambios durante el periodo CF sin embargo 

para el periodo FL aumentaría, así como la producción primaria neta de carbono 

sería más alta debido a la mayor presencia de CO2 mientras que el carbono 

orgánico en el suelo disminuiría en todos los escenarios puesto que tendría un clima 

más cálido. Como conclusión los autores señalan que estas proyecciones son útiles 

para tomar decisiones adecuadas y ejecutar un buen manejo integrado de la 

cuenca, así como los ecosistemas de las regiones montañosas de Loess (p. 4 - 9). 

(León, 2020) en su tesis: Modelo de gestión del recurso hídrico en la cuenca 

del río Tarqui, analizando escenarios de cambio climático mediante la herramienta 

de simulación HYDRO – BID tuvo de principal objeto gestar un modelo de gestión 

hidrológico para la cuenca en mención en Ecuador y mediante el uso de HYDRO-

BID simular escenarios para el cambio climático, para ello el autor primeramente, 

determinó la morfometría de la cuenca, para con esta información generar 

información de diagnóstico para la gestión y el análisis, luego, mediante la 

recopilación de data de precipitación, temperatura y caudales de las estaciones 

cercanas a la cuenca, usó esta información para simular y determinar los posibles 

impactos que se suscitarían en un escenario del CC sobre el río Tarqui para un 

periodo de 50 años y una simulación de cuatro escenarios con la variación de 

caudal y porcentaje de variación. Finalmente, el autor concluye que, debido al 

aumento poblacional, la expansión de la frontera ganadera, agrícola e industrial la 

cuenca se verá sometida a un estrés hídrico en el futuro y que es primordial tomar 

medidas de control, así como la generación de planes de prevención y cuidado de 

fuentes hídricas. 

(Zaldivar, 2017) en su tesis titulada “La cuenca hidrográfica como propuesta 

de unidad de análisis y gestión sustentable del territorio. Caso de estudio cuencas 

de los ríos Limarí y Rapel a partir de la información del VII Censo Nacional 

Agropecuario” por principal objetivo principal tuvo el analizar la factibilidad respecto 

a un estudio piloto del caso al usar a las cuencas como división territorial en un 
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país, esto para reordenar la información de índole social y productiva del VII Censo 

Agropecuario a través de la gestión de la actividad forestal y agropecuaria de la 

zona de estudio a través de una perspectiva basada en la sustentabilidad. Para ello 

se identificaron los predios con actividad agrícola por medio del censo 

agropecuario, para poder integrarlos en la cuenca correspondiente. Luego 

desarrollaron una interpretación de las imágenes satelitales obtenidas de los 

identificados, por lo que se digitalizó y cuantificó la superficie agrícola del territorio 

de acuerdo a la cuenca. Finalmente se aplicó un criterio metodológico para 

identificar aquellos distritos con actividad agrícola nula o que no son reconocidos 

en el espacio y tiempo de estudio lo que permitirá una mejor toma de decisiones (p. 

6). 

(Brombal, y otros, 2018) en su investigación titulada: “Una evaluación 

participativa de la sostenibilidad para la gestión integrada de cuencas hidrográficas 

en las zonas urbanas de China”, tuvo como objetivo general la evaluación de la 

sostenibilidad de la gestión de la cuenca del Lago Lihu en la ciudad de Wuxi, donde 

entre el 2002 y el 2012 se implementó un plan en manejo integrado de cuencas, 

para ello los autores evaluaron las dimensiones ambientales, económicas y 

sociales de la cuenca y obtuvieron como resultado a través de la medición 

cuantitativa del índice de sostenibilidad que el impacto de las medida 

implementadas fue positiva, se realizaron mejoras en la dimensión ambiental y 

económica, sin embargo la dimensión social tuvo una mejora pero no muy notable 

como en las otras dimensiones pues la reubicación de los miles de residentes y 

trabajadores, no estuvo acompañada de medidas que garanticen su reempleo ni 

acceso a sus fuentes tradicionales de sustento (agricultura y piscicultura). Como 

conclusión los autores señalan que el caso de Lihu es representativo pues tiene un 

resultado positivo en superar la brecha la economía y el ambiente, sin embargo, se 

deben realizar grandes esfuerzos para superar los problemas sociales en la gestión 

integrada de la cuenca, también señalan que los estudios de este tipo juegan un 

papel importante para evaluar las deficiencias y facilitar la transición hacia la mejora 

(p. 54-63). 

(Juarez, y otros, 2017) en su tesis titulada “Aportes del análisis de las 

características morfométricas de la cuenca hidrográfica del arroyo Santa Bárbara 
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para el diagnóstico ambiental” tuvo como objetivo principal la obtención de las 

características morfométricas y de esta forma poder comprender la dinámica que 

tiene el arroyo Santa Bárbara a través del uso del programa QGIS, para ello se 

analizaron los parámetros forma, longitud axial, perímetro, área y ancho promedio 

con esto se puedo calcular el factor de forma de la cuenca y el coeficiente de 

Gravelius y así poder el riesgo en la cuenca de las crecidas. El autor concluye que 

a través del análisis morfométrico de la cuenca en estudio se pudo obtener datos 

de gran relevancia y de esta forma obtener la información sobre la dinámica del 

curso de agua con la finalidad de predecir los riesgos de inundación y erosión, 

además de las gradientes de las variables de calidad de agua y el funcionamiento 

trófico, por lo que aplicar el análisis morfométrico se convierte en una manera 

fundamental para realizar el diagnostico ambiental de una cuenca (p. 8). 

(Águila, y otros, 2021) en su investigación titulada “Caracterización 

morfométrica de dos cuencas altoandinas del Perú utilizando sistemas de 

información geográfica” tuvo como objetivo principal analizar y caracterizar la 

morfometría de dos cuencas: Anya y Machique, para ello se realizó el cálculo de 

sus parámetros geomorfológicos y de este modo poder explicar sus respuestas 

hidrológicas. Se seleccionó información cartográfica base, para delimitar la CH y se 

calculó los parámetros básicos de cada cuenca y se calculó, alargamiento, 

elongación, coeficiente de compacidad, factor de forma, relación de bifurcación y 

densidad de drenaje. Finalmente, el autor señala como conclusión que al realizar 

el análisis morfométrico de las CH nos da una noción de lo que se considera la 

base de los estudios hidrológicos a través de uso del software ArcGIS y técnicas 

de computación para obtener resultados con un rápido entendimiento de la 

dinámica física presente en las redes de drenaje de cuencas hidrográficas (p. 7). 

A continuación, se definen algunos conceptos que ayudarán a la 

retroalimentación del tema: 

El agua es un elemento de incalculable valor, además de ser esencial en la 

vida, así como para su desarrollo, el usarla eficientemente resulta clave para la 

sustentabilidad, sin embargo, existe muchos desafíos asociados con la gestión 
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integral del agua es por ello que es necesaria una adecuada gestión integrada de 

los recursos hídricos (Quintana, 2020, p. 6). 

Gutiérrez (2018) asevera que “El aumento de la población, así como el 

transcurso rápido de la industrialización, el turismo, el crecimiento de la ganadería 

y la agricultura como las ciudades, además del cambio climático ejercen una fuerte 

presión en el recurso hídrico de los países en el mundo” (p.18). 

Además, según (Uvidia & Villagómez, 2020, p. 32) la población mundial tiene 

un crecimiento exponencial que causa alta demanda de los recursos naturales, de 

allí se genera un gran interés en conservar estos recursos con un enfoque integrado 

en desarrollo sostenible (Ver figura 1). 

Figura 1. Desarrollo sostenible 

 

Fuente: (Línea Verde, 2018) 

La vulnerabilidad viene a ser el grado de susceptibilidad para hacer frente a 

diferentes efectos que puede traer consigo el cambio climático, teniendo en cuenta 

principalmente los climas de la zona y las variaciones meteorológicas presentes. 

Esta se puede trabajar teniendo en cuenta las variaciones climáticas, magnitudes 

 

 

Económico 

 Medioambiental  Social 



14 

 

y caracteres de las mismas que pueden afectar al sistema en cuestión, su 

adaptación y sensibilidad (Jiménez, 2016, p. 28). 

Además, Según (Espinosa, 2016, p. 34) la vulnerabilidad puede ser 

interpretada también teniendo en cuenta el grado de exposición que posee el 

sistema, la sensibilidad y su capacidad adaptativa, teniendo en cuenta la siguiente 

formulación: 

𝑉𝑢𝑙𝑛𝑒𝑟𝑎𝑏𝑖𝑙𝑖𝑑𝑎𝑑 = 𝑓(𝐸𝑥𝑝𝑜𝑠𝑖𝑐𝑖ó𝑛, 𝑆𝑒𝑛𝑠𝑖𝑏𝑖𝑙𝑖𝑑𝑎𝑑, 𝐶𝑎𝑝𝑎𝑐𝑖𝑑𝑎𝑑 𝐴𝑑𝑎𝑝𝑡𝑎𝑡𝑖𝑣𝑎) 

Y de esta formulación se puede entender de la exposición como unidad 

aquella actividad, o variación climática significativa que se pueda dar en la unidad 

en mención. En el caso de sensibilidad se puede entender como el grado de 

afectación positiva o negativa de las variaciones climáticas. Y en el caso de la 

capacidad adaptativa se puede entender como la capacidad del sistema para poder 

ajustarse a las variaciones climáticas. Teniendo en cuenta todos estos conceptos 

se podría estudiar y anticipar de cierta manera el daño potencial y poder hacer 

frente a las condiciones futuras. 

Es así que la vulnerabilidad de un sistema, subsistema o componente se 

puede identificar como aquella posibilidad que este posea para afrontar algún daño 

a consecuencia de la exposición del mismo a un factor de estrés, algún riesgo o 

perturbación. Teniendo en cuenta que el sistema sea capaz de poder hacer frente 

al CC en diferentes escenarios que se puedan presentar en el sistema, subsistema 

o componente (Espinosa, 2016, p. 35). 

Por ello en la evaluación de la vulnerabilidad se da primordialmente el 

análisis de las variaciones climáticas y el efecto que puedan tener en el entorno 

social del sistema estudiado y la adaptabilidad que este posea. Luego de realizar 

este análisis se procede con otro análisis más complejo en el que se puede evaluar 

la adaptabilidad no solo del entorno social, sino también teniendo en cuenta la 

adaptación del entorno ambiental y otros aspectos de acuerdo a la metodología 

seleccionada para su análisis (Jiménez, 2018, p. 28). 
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Para la evaluación de la vulnerabilidad en el presente trabajo se hace uso 

de la metodología que fue elaborada por (Valencia, et al, 2016) en la que se calcula 

una lista de indicadores que podrán ser utilizados en base a la formulación que se 

tocó anteriormente, enfocándonos en los indicadores del sistema elegido que en 

este caso es la cuenca hidrográfica Ilo Moquegua. 

● Biofísica 

✔ Índice de Uso de Agua 

✔ Índice de fragmentación 

✔ Precipitación 

✔ Coberturas Reguladoras del ciclo hidrológico 

✔ Índice de regulación hídrica 

✔ Caudal 

✔ Temperatura 

✔ Índice de calidad de agua 

● Político institucional 

✔ Actores relacionados con el recurso hídrico en la cuenca 

✔ Inversiones del acueducto en gestión ambiental para la cuenca 

● Económico productivo 

✔ % Cobertura acueducto rural 

✔ % Cobertura acueducto urbana 

● Socio cultural 
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✔ Percepción de eficiencia del servicio de acueducto usuarios 

zona urbana. 

✔ Densidad poblacional rural  

✔ Percepción de eficiencia del recurso hídrico por usuarios zona 

rural. 

✔ Densidad poblacional urbana 

Además, se toman en cuenta algunos escenarios que se pueden presentar 

en el cambio climático: 

Tabla 1. Escenarios del cambio climático  

Escenario Descripción 

Presente 
Se basa en el comportamiento usual de la cuenca sin incidencia 

de eventos del clima de carácter extremo. 

Niño 

Moderado 

La variabilidad climática es moderada con una incidencia en el 

componente de exposición, lo que disminuye la precipitación y el 

caudal, todo ello mientras la temperatura se incrementa. Las otras 

variables poseen un comportamiento normal. 

Niña 

Moderado 

Tiene una variabilidad climática moderada con repercusión en el 

componente de exposición, se incrementa la precipitación y el 

caudal, mientras la temperatura decrece. Las otras variables 

poseen un el comportamiento normal 

Con baja 

capacidad 

adaptativa 

(BCA) 

Se considera una disminución en los indicadores del componente 

de capacidad adaptativa: Actores relacionados con los RRHH, 

Inversión del acueducto en gestión ambiental para la cuenca, % 

Cobertura acueducto rural y urbano. Los anteriores cambios 

inciden sobre otras variables del modelo lo que disminuye el 

índice de calidad de agua, las coberturas reguladoras del ciclo 

hidrológico, la percepción de eficiencia del servicio de acueducto 

usuarios zona urbana y rural. También incrementando los Índices 
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de fragmentación y de uso de Agua, la densidad poblacional rural 

y urbana 

Con alta 

capacidad 

adaptativa 

(ACA) 

Se da un incremento en los indicadores del componente de 

capacidad adaptativa: Actores relacionados con el recurso hídrico 

en la cuenca, inversión del acueducto en gestión ambiental para 

la cuenca, % de cobertura acueducto rural y urbano. Dichos 

cambios influyen sobre otras variables del modelo incrementando 

el índice de calidad de agua, la percepción de eficiencia del 

servicio de acueducto usuarios zona urbana, las coberturas 

reguladoras del ciclo hidrológico, la percepción de eficiencia del 

recurso hídrico por usuarios zona rural, la densidad poblacional 

rural y urbana. También los índices de fragmentación y de uso de 

Agua decrecen. 

Fuente: (Valencia, et al., 2016, p. 38) 

Por otro lado, en el año 2009, se creó la ANA y así como la ley de Recursos 

hídricos 29338, por lo que nuestro país inició un proceso de cambio en las 

instituciones respecto a la gestión de sus recursos hídricos, es por eso que el 

estado peruano esperó poder instaurar un modelo de gobierno basado en el 

enfoque de GIRH, es decir, una estructura de gestión que permita garantizar la 

eficiencia en el uso del agua, la equidad en el acceso y la integridad ecológica, lo 

que produciría un efecto positivo para reducir la alta conflictividad de la competencia 

por el agua entre las actividades económicas peruanas (Geng, 2016, p. 21). 

Las reformas institucionales introdujeron la reorganización administrativa, 

así como territorial de la gestión del agua, a través del planteamiento de cambios 

en las relaciones de poder entre los actores del agua. Por la parte administrativa se 

dio origen a los organismos desconcentrados como los ALA y AAA, estos se 

constituyeron como un rango de nivel medio que mediaría entre la gestión local y 

nacional de los recursos hídricos (Geng, 2016, p. 21). 

A nivel territorial, la cuenca hidrográfica se reconoció como una unidad de 

gestión, es decir, una referencia territorial a partir de la cual implementar políticas y 
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establecer jurisdicciones. Por último, a nivel político, se amplió la participación en 

la gestión del agua a la sociedad a través de la creación del consejo de recurso 

hídrico de cuenca, así los usuarios del agua tendrían la posibilidad de participar en 

la toma de decisiones sobre los recursos hídricos de su cuenca por intermedio de 

los representantes que escogieran (Geng, 2016, p. 21).  

Según ANA (2021) define a una cuenca hidrográfica como un “Área que se 

encuentra delimitada por un límite topográfico bastante notorio (parteaguas). 

Dentro de este límite la cuenca presenta un complejo de geoformas, suelos, 

vegetación, fauna, entre otros componentes” (Párr. 1). 

(ANA, 2018) bajo un enfoque hidrológico define a la cuenca como cualquier 

área de superficie desde la cual la escorrentía resultante de la lluvia se recoge y se 

drena a través de un punto común, esta puede tener solo unas pocas hectáreas o 

cientos de kilómetros cuadrados y se puede dividir en subcuencas más pequeñas 

(p. 10). 

El enfoque de cuencas permite gestionar de forma más clara un área a nivel 

geográfico e hidrológico. Es así que la gestión de aguas debe ignorar los límites 

administrativos y políticos, ya que los conflictos típicos de un área de gestión son 

conflictos de usuarios río arriba – río abajo que incluyen impactos al medio 

ambiente y a las condiciones socioeconómicas. En zonas rurales la mayoría de 

conflictos tienen orígenes directos e indirectos por el uso del agua, y un enfoque en 

cuencas hidrográficas aborda directamente los conflictos de los usuarios de agua 

río arriba con los de río abajo lo que permitirá conducir a la solución del problema 

(Thiermann, Schubert, & Schutt, 2018, p. 11). 

Según Ruelas & Travieso (2017) “Una cuenca que se encuentra en 

equilibrio, sin presión de uso de suelo y alteración de sus recursos naturales no 

requerirá ser gestionada, sin embargo, actualmente es poco probable pues existen 

diferentes situaciones de contaminación ambiental, tanto de aguas, como la erosión 

de suelo, falta de ordenamiento territorial, inundaciones, etc., es por ello que es 

necesario aplicar alternativas que logren impactos positivos en el desarrollo 

sostenible y bienestar humano” (p. 5). 
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Figura 2. Agua, recurso integrador y estratégico. 

 

Fuente: Elaboración propia 

Moreira, et al., (2020) señala que “Un enfoque en cuencas hidrográficas 

puede ser tomado como una forma de ordenar y planificar ambiental y 

territorialmente un espacio, además de que la cuenca funciona como una unidad 

básica para el análisis ambiental, pues permite evaluar los componentes, 

interacciones y procesos que ocurren dentro de ella, por lo que a la hora de ejecutar 

acciones este enfoque permite tener en cuenta la conservación de los recursos de 

la cuenca” (p. 71). 

El hecho de comprender a una cuenca como la unidad sistémica, puede ser 

fundamental a la hora de proporner acciones y medidas de planificación y manejo 

ambiental, pues la gestión integrada se orienta hacían el ordenamiento adecuado 

del uso del suelo, la preservación del agua y la minimización de impactos originados 

de forma antropogénica por las actividades económicas que se dan en el interior 

de la cuenca (Moreira, et al., 2020, p. 82). 

Pero debido a que la cuenca funciona como una unidad territorial, las 

estrategias y los problemas que puedan surgir de la gestión hídrica serán de toda 
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esta misma. La solución a estos problemas va a requerir de la coordinación de los 

actores involucrados existentes, independientemente de los aspectos políticos de 

la zona. No se decide cuál de los planes priorizar, sino por el contrario motivar el 

enlazamiento o cooperación entre todos los planes para evitar vacíos o 

superposiciones lo que dará como resultado el uso óptimo de la cuenca (Paris & 

Marano, 2017, p. 59).  

Por otro lado, el cambio climático tiene en escenarios como representación 

plausible que significa muy frecuentemente nos dan indicios del clima futuro y que 

tiene relación con las condiciones climáticas que serán utilizadas en esta 

investigación para determinar si existe el cambio climático, que es la diferencia 

entre este cambio dado y el clima actual. En las siguientes décadas el escenario 

actual experimentará aumentos de temperatura, tanto en los océanos como en la 

superficie terrestre, entre otros impactos. Por ende, al vincular el cambio climático 

al manejo integral de cuencas se necesita reconocer que cada cuenca según sea 

la estructura que posea y las funciones que cumple, su manejo y ubicación además 

de los aspectos climáticos nos permitirán hacer frente a los efectos que pueda 

generar este CC en la cuenca en mención, en este caso en la cuenca Hidrográfica 

del rio Moquegua (Ríos, 2017, p. 4).  
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III. METODOLOGÍA 

5.1 Tipo y diseño de investigación 

La investigación es de tipo aplicada pues se basa en la investigación básica 

para resolver problemas de la sociedad, además este tipo de investigación se 

centra en la resolución de un problema en un contexto determinado, es decir que 

busca la aplicación del conocimiento mediante su uso, es decir que se enfoca en la 

búsqueda y consolidación de la información para su posterior aplicación y por ende 

el enriquecimiento del desarrollo científico y cultural. El presente trabajo recopila 

información sobre la cuenca Moquegua para medir su grado de vulnerabilidad y por 

ende proponer estrategias para afrontar el cambio climático, para su posterior 

aplicación en la toma de decisiones por parte de las autoridades (Nieto, 2018, p. 1). 

El enfoque de la investigación es cuantitativo porque se encuentra orientado 

sobre los pasos del método científico con el objeto de generar nuevos 

conocimientos, además establece una o varias hipótesis, variables y se traza un 

plan para probarlas, seguidamente se miden las variables en un determinado 

contexto y se analiza las mediciones obtenidas a través de método estadísticos y 

finalmente se extrae una serie de conclusiones. En el presente trabajo se analiza 

el entorno en el que se desarrolla la cuenca Moquegua y se comprueba si la 

hipótesis planteada es verdadera, así como las variables que influyen (Hernández, 

Fernández, & Baptista, 2017, p. 4). 

El diseño de la investigación es no experimental ya que esta investigación 

se observa los fenómenos más no se interviene en su desarrollo (Cabrero, et al, 

2020, párr. 1). 

5.2 Variables y operacionalización 



Tabla 2. Operacionalización de variables 

Variables Definición conceptual Dimensiones Indicadores 

Variable independiente  

Vulnerabilidad de la cuenca 

hidrográfica Ilo - Moquegua  

Grado de exposición que 

posee el sistema, la 

sensibilidad y su 

capacidad adaptativa 

Situación actual de la 

cuenca de la cuenca 

Parámetros generales de la cuenca 

Parámetros relativos a la red de drenaje de la cuenca 

Parámetros de forma de la cuenca 

Parámetros de relieve de la cuenca 

Biofísica  

Índice de Uso de Agua 

Caudal 

Coberturas Reguladoras del ciclo hidrológico 

Índice de fragmentación 

Índice de calidad de agua 

Precipitación  

Temperatura Índice de regulación hídrica 

Político institucional 

Actores relacionados con el recurso hídrico en la cuenca 

Inversiones del acueducto en gestión ambiental para la 

cuenca 

Económico productivo 
% Cobertura acueducto urbana 

% Cobertura acueducto rural 

Socio cultural 

Percepción de eficiencia del servicio de acueducto usuarios 

zona urbana. 

Densidad poblacional urbana 

Percepción de eficiencia del recurso hídrico por usuarios zona 

rural  
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Densidad poblacional rural 

Variable dependiente  

Diferentes escenarios del 

cambio climático  

Escenarios presentes en el 

cambio climático con 

cambios en diferentes 

indicadores 

Presente 

Niño Moderado 

Niña Moderado 

Con baja capacidad 

adaptativa (BCA) 

Con alta capacidad 

adaptativa (ACA) 

Comportamiento normal 

Variabilidad climática moderada 

Disminución de la capacidad adaptativa 

Aumento de la capacidad adaptativa 

Estrategias de la cuenca Propuesta de estrategias 

Fuente: Elaboración propia 



5.3 Población, muestra, muestreo y unidad de análisis 

5.3.1 Población 

La población corresponde a toda la cuenca Hidrográfica del rio Moquegua. 

5.3.2 Muestra 

La muestra sería no probabilística, por ende, se toma en cuenta como 

muestra a toda la población seleccionada que en este caso vendría a ser la cuenca 

Hidrográfica del río Moquegua. 

5.3.3 Muestreo 

En la presente investigación, el método utilizado para la selección de nuestra 

muestra, es el muestreo no probabilístico, que consiste en la selección de 

elementos de la muestra sin asignar una probabilidad antes conocida a cada 

elemento de la población. Se tiene que tener en cuenta el juicio del investigador, en 

lugar de realizar un procedimiento para la selección de ciertos elementos de la 

población respectiva (Salas, 2020, párr. 10). 

5.3.4 Unidad de análisis 

Se tomó como unidad de análisis a la cuenca hidrográfica de Moquegua, la 

cual se encuentra ubicada en la costa sur del territorio peruano, políticamente 

abarca parte de las provincias de Mariscal Nieto e Ilo, ambas pertenecientes a la 

región Moquegua, que comprende un área de 616,22 Km2 de la provincia de Ilo y 

2988,53 Km2 de la provincia de Mariscal Nieto, haciendo obteniendo un área de 

3604.75 km2 (INGEMMET, 2019, p.5). 

La cuenca posee un relieve variado y agreste que nace de una compleja 

actividad volcánica y tectónica. Con una precipitación muy baja de 419.47 metros 

cúbicos de agua por año, que se produce en la parte alta de la cuenca a través de 

una recarga natural que favorece el acuífero fisurado Barroso y al volcánico 

sedimentario Capillune.  
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Además, en la cuenca se identificaron sectores contaminados por un uso 

excesivo de productos químicos en la agricultura como fertilizantes y plaguicidas, 

botaderos de residuos sólidos, quema de residuos y la disposición final de residuos 

líquidos (aguas servidas vertidas directamente en el acuífero) que afectan la calidad 

ambiental de la ciudad de Moquegua (INGEMMET, 2019, p.9). 

5.4 Técnicas e instrumentos de recolección de datos 

Se usaron las técnicas: investigación y análisis documental, además se 

utilizaron instrumentos para determinar los parámetros morfométricos de la cuenca 

Moquegua como son:  

- Computadora 

- ArcGIS 10.4 

- Imágenes satelitales 

- Información bibliográfica 

- Microsoft Excel 

- Software HEC HMS 

Para la obtención de datos meteorológicos se usó el programa NASA 

POWER que contiene datos relacionados a la meteorología y la energía solar, este 

software fue formulado para con la finalidad de diseñar sistemas de energía 

renovable, pero puede tomarse como referencia para completar la data 

meteorológica que no se pueda obtener del SENAMHI. 

5.4.1 Validez y confiabilidad 

Las fuentes con las que se trabajó son de artículos académicos de revistas 

indexadas pertenecientes a fuentes como Scielo, Scopus, Dialnet, ResearchGate, 

además se obtuvo información de la cuenca y el marco legal de instituciones como: 

ANA, SENAMHI, INGEMMET, MINAM, SINIA y tesis obtenidas en el Google 

Académico. 
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5.5 Procedimientos 

El presente trabajo se realizó en base a la metodología para el análisis de 

vulnerabilidad en cuencas abastecedoras de agua ante la variabilidad climática 

elaborado por (Valencia, et al., 2016, p 30) y se divide en las siguientes etapas: 

Etapa Inicial. – En esta etapa se recopilaron datos y se clasificó la 

información obtenida sobre la cuenca Moquegua de las diferentes instituciones 

públicas y privadas de los últimos 30 años, es decir, desde el año 1990 al 2020.  

Etapa Intermedia. – En esta etapa se analizaron los datos obtenidos del 

área de estudio y se evaluará las siguientes dimensiones: Biofísica, Político – 

institucional, Económico productivo, Socio Cultural, de acuerdo a la guía 

metodológica y posteriormente los indicadores para determinar el grado de 

vulnerabilidad de la cuenca Moquegua. 

Etapa Final. – En esta etapa por último se llevó a cabo el análisis, evaluación 

y reajuste de toda la información obtenida en las etapas anteriores para proponer 

estrategias para afrontar el cambio climático, las cuales se sugirieron de acuerdo al 

diagnóstico de la cuenca y el grado de vulnerabilidad de la misma. 

5.6 Método de análisis de datos 

Para determinar la vulnerabilidad de la cuenca Moquegua ante los efectos 

del cambio climático (Valencia, et al., 2016, p. 33) indica que es necesario analizar 

tres componentes que fueron propuestos por el IPCC y son: 

● Exposición: Grado en el que la cuenca se encuentra expuesta a 

variaciones climáticas extremas. 

● Sensibilidad: Grado en el cual la cuenca responderá a un cambio 

dado en el clima, incluyendo efectos beneficiosos o dañinos. 

● Capacidad de adaptación: Son los medios por los cuales la sociedad 

usa los recursos disponibles y habilidades para afrontar las 

consecuencias sobre la cuenca. 
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(Valencia, et al., 2016, p. 33) indica que para conseguir que el análisis tenga 

un enfoque sistémico y tenga en cuenta los factores extrínsecos (modelos y 

políticas de desarrollo nacional e internacional, cambio global) e intrínsecos 

(saberes tradicionales, políticas locales, patrones culturales y tipo de ecosistema) 

que determinan la vulnerabilidad de los sistemas considerados, para ello el autor 

señala una serie de pasos a seguir y estos son: 

5.6.1 Paso 1: Delimitación de las características del modelo 

Con la finalidad de delimitar el alcance que tendrá el análisis de 

vulnerabilidad, se tiene que responder las siguientes interrogantes teniendo en 

cuenta los atributos de vulnerabilidad (Valencia, et al., 2016, p. 33): 

● ¿Quién o qué es vulnerable?  

● ¿Frente a que se es vulnerable? 

● ¿Cuándo o en qué momento es vulnerable? 

● ¿Cuál es el atributo específico de la vulnerabilidad? 

5.6.2 Paso 2: Definición de dimensiones en la cuenca 

(Valencia, et al., 2016, p. 33) señala las siguientes dimensiones: 

1. Biofísica:  

Toma como base a un grupo de estructuras y relaciones en el contexto 

abiótico y biótico. 

2. Político institucional 

Constituye la capacidad de la gestión administrativa institucional y fiscal de 

las instituciones de los distintos niveles como son: local, departamental y nacional 

3. Económico productiva 
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Consta de las dinámicas económicas de los servicios y productos 

relacionados con la cuenca. 

4. Socio cultural 

Corresponde a las interacciones y características de las comunidades 

humanas en el interior de la cuenca. 

5.6.3 Paso 3: Selección de indicadores. 

Tabla 3. Indicadores seleccionados 

Dimensión Indicadores Unidad 

Biofísica Coberturas Reguladoras del ciclo 

hidrológico  
Unidad 

Índice de regulación hídrica Unidad 

Índice de fragmentación Unidad 

Índice de calidad de agua  Unidad 

Índice de Uso de Agua Unidad 

Precipitación Mm 

Caudal m3/s 

Temperatura °C 
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Político 

institucional  

Inversiones del acueducto en 

gestión ambiental para la cuenca 
% 

Actores relacionados con el 

recurso hídrico en la cuenca 
# 

Económico 

productivo 

% Cobertura acueducto rural % 

% Cobertura acueducto urbana % 

Socio cultural Densidad poblacional rural  hab./km2 

Densidad poblacional urbana hab./km2 

Percepción de eficiencia del 

recurso hídrico por usuarios zona 

rural. 

% 

Percepción de eficiencia del 

servicio de acueducto por 

usuarios zona urbana. 

% 

Fuente: (Valencia, et al., 2016, p. 35) 

5.6.4 Paso 4: Fórmula para el análisis de la vulnerabilidad 

Teniendo en cuenta que la vulnerabilidad (V) que se encuentra dependiente 

de la sensibilidad (se), capacidad adaptativa (ca) y exposición (ex), se puede 

expresar de la siguiente manera:  

𝑉 = 𝑒𝑥 + 𝑠𝑒 − 𝑐𝑎 +
1

3
                                                           (1) 
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Luego se procederá a calcular los componentes (se, ex, ca) tomando el valor 

ponderado (mediante la normalización métrica) de los indicadores (pn) y sus pesos 

o relevancias (wn) en la vulnerabilidad sistemática a través de las ecuaciones 

siguientes: 

 

𝑒𝑥 =  ∑𝑛
𝑖=1 𝐼𝑖 =  𝐼(𝑝1)(𝑤1) + 𝐼(𝑝2)(𝑤2)+𝐼(𝑝3)(𝑤3) + 𝐼𝑛 = 1               (2) 

𝑠𝑒 =  ∑𝑛
𝑖=1 𝐼𝑖 =  𝐼(𝑝1)(𝑤1) + 𝐼(𝑝2)(𝑤2)+𝐼(𝑝3)(𝑤3) + 𝐼𝑛 = 1               (3) 

𝑐𝑎 =  ∑𝑛
𝑖=1 𝐼𝑖 =  𝐼(𝑝1)(𝑤1) + 𝐼(𝑝2)(𝑤2)+𝐼(𝑝3)(𝑤3) + 𝐼𝑛 = 1               (4) 

 

Según la metodología propuesta la vulnerabilidad tiene seis valores 

equidistantes de interpretación: 

Figura 3. Rangos para la interpretación de la vulnerabilidad 

 

      

0                0.16              0.33               0.50              0.67            0.84                 1 

Muy bajo Bajo Medio bajo Medio alto Alto Muy alto 

Fuente: (Valencia, et al., 2016, p. 36) 
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5.6.5 Paso 5: Evaluación de la vulnerabilidad actual y futura 

(Valencia, et al., 2016, p. 37) plantea los escenarios de análisis para evaluar 

la vulnerabilidad actual y futura, siendo: El presente, Niño Moderado, Niña 

Moderado, con baja capacidad adaptativa (BCA) y con alta capacidad adaptativa 

(ACA). 

5.7  Aspectos éticos 

El investigador tiene el compromiso de cumplir con los aspectos éticos, por 

ningún motivo se falsificaron los datos pues esto afectaría los resultados de la 

investigación. Se utilizó información de carácter público la cual fue referenciada 

según la norma ISO 690.  
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IV. RESULTADOS 

5.8 Paso 1: Delimitación de las características del modelo 

(Valencia, et al., 2016, p. 33) plantea en su metodología las siguientes 

interrogantes: ¿Quién o qué es vulnerable?, ¿Frente a que se es vulnerable?, 

¿Cuándo o en qué momento es vulnerable?, ¿Cuál es el atributo específico de la 

vulnerabilidad? Y para responder a las siguientes interrogantes es necesario 

tratarlo por partes y definir los parámetros morfológicos de la cuenca para 

responder ¿Quién o qué es vulnerable? 

La cuenca Ilo - Moquegua se encuentra en la Costa Sur del Perú abarcando 

el Departamento de Moquegua, así también las Provincias Mariscal Nieto e Ilo, 

geográficamente entre los paralelos 16º 52´ y -17º 43´ de Latitud Sur y los 

meridianos 70º 26´ y -71º 20´ de Longitud Oeste (ANA, 2016, p. 2).  

Sus Limites son: Por el Norte la cuenca del río Tambo, al Este y al Sur con 

la cuenca del río Locumba, al Oeste con la cuenca del Océano Pacífico y la 

intercuenca entre Moquegua y Tambo, el cual está compuesto por una sucesión de 

quebradas de mediana y corta longitud y sus aguas son drenadas al Océano, pues 

pertenece a la vertiente del pacifico (ANA, 2016, p. 2). 
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Figura 4. Delimitación de la cuenca Moquegua 

 

Fuente: Elaboración propia 

5.8.1 Divisoria del Agua 

Se define como la línea imaginaria que delimita la Cuenca Moquegua, 

marcando el límite entre cuenca Moquegua y las demás cuencas. El agua 

precipitada a cada lado de la divisoria desemboca en los ríos de Torata, R. 

Chujulay, R. Cuajone, R. Capillune, R. Tumilaca, correspondientes a la Zona de 

Recarga (Ministerio de Desarrollo Agrario y Riego, 2017, p. 19). 

5.8.2 Río Principal 

El río principal de la Cuenca Moquegua es el Río Moquegua, con un curso 

de mayor caudal de agua y de mayor longitud. (Ministerio de Desarrollo Agrario y 

Riego, 2017, p. 20) 
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5.8.3 Tipo de Cuenca 

El tipo de cuenca es exorreica o abierta, la Cuenca Moquegua por su 

dirección de la evacuación de las aguas que drenan al mar en la vertiente del 

Pacífico (ANA, 2016, p. 3). 

5.8.4 Parámetros generales de la cuenca 

Los parámetros fueron determinados en el programa Arc Gis 10.4 y según 

(Camino, et al., 2018, p. 4) los parámetros generales de una cuenca son: 

Área (A): Se mide en kilómetros cuadrados. Según el software Arc Gis 

10.4.1 es: 3531.2 km². 

Perímetro (P): Longitud de la línea que limita una cuenca. Como resultado 

se tiene 382.981 km. 

Longitud axial (La): Es la longitud en línea recta del punto que se encuentra 

más distante del límite de aguas y de la desembocadura en una cuenca además 

enlaza los puntos extremos de la misma. De acuerdo al software se tiene 126.35 

km. 

Ancho (W): Es el enlace entre un área de cuenca (A) y una longitud axial 

(La) como se observa en la ecuación 1, siendo su valor de 27.95 km. 

𝑊 =
𝐴

𝐿𝑎
                                                          (1) 

Reemplazando en (1): 

𝑊 =
3531.2 𝐾𝑚2

126.35 𝐾𝑚  
 

𝑊 = 27.95𝐾𝑚 

Longitud total de los cursos de agua (Lt): Según (Camino, et al., 2018, p. 

4) es la sumatoria de las longitudes de todos los cursos de agua que drenan en una 

cuenca, para ArcGIS 10.4.1 la longitud total (Lt) es 965.409 Km, y se aprecia la red 

hídrica en la figura 5. 
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Figura 5. Longitudes del Cauce Principal y de la Red Hídrica de la Cuenca 

Moquegua 

 

Fuente: Elaboración propia 

5.8.5 Parámetros relativos a la red de drenaje 

Patrón de drenajes: Según (HidroCHEP, 2016) los patrones de drenaje son 

ramificaciones hidrológicas, producidas de forma natural y sus diferentes tipos se 

producen debido a la geología física y geomorfología planetaria, es decir la erosión 

provoca un caudal donde los patrones forman ríos, lagos y aguas subterráneas 

alimentadas por lluvias, nieve, entre otros. Existen diversos tipos de drenaje que se 

pueden ver en la figura 6. 

La cuenca Ilo-Moquegua presenta un tipo de patrón “Dendrítico” el cual se 

caracteriza por tener materiales homogéneos aproximadamente en su 

composición, sin control estructural. Constituye uno de los más comunes patrones 

y está presente en muchos ambientes. 
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Figura 6. Patrón de drenajes 

 

Fuente: (Geología Web, 2016) 

El orden de la cuenca Strahler: Según (Camino, et al., 2018, p. 8) el Orden 

Strahler es el número que expresa el grado de ramificación de un sistema 

hidrográfico y como resultado según el software es de orden 6. 
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Figura 7. Orden de la cuenca Strahler 

 

Fuente: Elaboración propia. 

Densidad de drenaje (D): Viene a ser el sistema de cauces en el que fluyen 

los escurrimientos subsuperficiales, superficiales y subterráneos, en forma 

permanente o temporal, por lo que a mayor densidad de drenaje se tiene un tiempo 

de escorrentía menor y por tanto es considerado un indicador de peligrosidad, en 

cuencas de alta densidad de drenaje y planas se espera estabilidad de regímenes 

de caudales debido al escurrimiento superficial además del aporte de aguas 

subterráneas. (Camino, et al., 2018, p. 8) Se representa según la ecuación 2: 

𝐷𝑑 =
𝐿𝑡

𝐴
                                                         (2) 

Reemplazando en (2) 

𝐷𝑑 =
965.409𝐾𝑚

3531.2 𝐾𝑚2
 

𝐷𝑑 = 0.27 𝐾𝑚−1 
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Tabla 4. Clasificación de la red de drenajes. 

Rangos(km/km2) Clase 

3,7 a 5,6 Alta 

1,9 a 3,6 Moderada 

0.1 a 1,8 Baja 

Fuente: (Camino, et al., 2018, p. 8) 

Según la tabla 4 el valor de 0.27 nos indica que la cuenca se encuentra en la 

categoría “Baja” lo que indica según (Camino, et al., 2018, p. 8) que es una región 

de alta resistencia a la erosión, muy permeables y de bajo relieve. 

5.8.6 Parámetros que caracterizan la forma de una cuenca 

Factor forma adimensional de HORTON (Kf): Según (Lux, 2017, p. 3) es 

la relación entre el cuadrado de la longitud de la cuenca y el área, intenta medir 

cuan cuadrada es la cuenca, un Kf superior a la unidad indica que una tendencia a 

concentrar escurrimiento de lluvia y, por tanto, tener grandes crecidas fácilmente, 

además cuanto más se acerque a cero más alargada será, cuando este cerca de 1 

o igual a 1 será de un ancho cuadrado y más alejado de 1 significa que es más 

ancho. De acuerdo a la ecuación 3: 

𝐾𝑓 =
𝐴

𝐿2                                                         (3) 

Reemplazando en (3) 

𝐾𝑓 =
3531.2 𝐾𝑚2

(126.35 𝐾𝑚)2
 

𝐾𝑓 = 0.22 
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La cuenca presenta un valor de 0.22 lo que nos indica que la cuenca Ilo-

Moquegua es de forma ALARGADA, lo que nos indica que tiene tendencias alta 

susceptibilidad a la formación de avenidas. 

Índice de compacidad o Gravelius (Kc): Según (Camino, et al., 2018, p. 6) 

este es un parámetro adimensional y compara el perímetro de la cuenca con el 

perímetro de un círculo teórico equivalente de la cuenca, según la ecuación 4:  

𝐾𝑐 =
𝑃

2√𝜋𝐴
                                                         (4) 

Reemplazando en (4) 

𝐾𝑐 =
383.2 𝐾𝑚 

2√𝜋(3531.2 )𝐾𝑚2
 

𝐾𝑐 = 1.81 

El índice de compacidad es mayor a 1 lo que indica que es una cuenca 

IRREGULAR ya que según (Camino, et al., 2018, p. 6) un valor cercano a uno 

significa que la cuenca se asemeja a un círculo, por ende, es regular, además la 

peligrosidad de la cuenca es mayor debido a las crecidas, porque se tiene una 

equidistancia relativa de los puntos de la divisoria respecto a la central, cuencas 

con valores superiores a 1.75 indican irregularidad y por tanto menos peligro a las 

crecidas. 

5.8.7 Parámetros que caracterizan el relieve de la cuenca 

Pendiente media de la cuenca: Según (Camino, et al., 2018, p. 7) viene a 

ser el valor medio de las pendientes, teniendo una gran importancia en el estudio 

de la infiltración, escurrimiento superficial, arrastre de material y recarga de 

acuíferos.  

Tabla 5. Clasificación de pendientes medias. 

Pendiente Tipo de relieve 
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0-3 Plano 

3-7 Suave 

7-12 Mediano 

12-35 Accidentado 

35-50 Fuerte 

50-75 Muy fuerte 

>75 Escarpado 

Fuente: (Camino, et al., 2018, p. 7) 

Según la tabla 5 la pendiente es de 15.19, que nos permite entender de que la 

cuenca es accidentada pero no demasiado. 

Curva Hipsométrica: Según Lux (2017) esta curva permite caracterizar el 

relieve obteniéndose a partir de cotas de altitud registradas versus el porcentaje de 

área acumulado por cota. (p. 5) 

En la tabla 6 se obtienen estos valores para la cuenca Moquegua en el 

programa ArcGIS 10.4.1. 

 

Tabla 6.  Cotas para la curva hipsométrica. 

N° de 

cota 

Intervalo 

entre curvas 

de nivel [m] 

Cota 

medi

a (m) 

Área 

(Km²) 

Área/Áre

a Total 

[%] 

Porcentaje 

Acumulad

o 

ai ci 

MIN MAX 

1 4944 5492 5218 57.6 1.63% 1.63% 300556.8 

2 4396 4943 
4669.

5 
360.3 10.20% 11.83% 

1682420.8

5 
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3 3848 4395 
4121.

5 
308.2 8.73% 20.56% 1270246.3 

4 3299 3847 3573 287.5 8.14% 28.70% 1027237.5 

5 2751 3298 
3024.

5 
268.1 7.59% 36.30% 810868.45 

6 2203 2750 
2476.

5 
337.5 9.56% 45.85% 835818.75 

7 1654 2202 1928 353 10.00% 55.85% 680584 

8 1106 1653 
1379.

5 
817.2 23.14% 78.99% 1127327.4 

9 558 1105 831.5 647.9 18.35% 97.34% 538728.85 

10 9 557 283 93.9 2.66% 100.00% 26573.7 

Fuente: Elaboración propia. 

 

Área Total (Km²) 3531.2 

∑ ai*ci 
8300362.6 

Altura Media (m) 2750.5 

 

 

Figura 8. Curva hipsométrica de la cuenca Moquegua 
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Fuente: Elaboración propia 

Figura 9. Curva hipsométrica. 

 

Fuente: Elaboración propia. 
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5.9 Paso 2 y Paso 3 

5.9.1 Biofísica 

5.9.1.1 Índice de regulación hídrica 

El índice de regulación hídrica (IRH) se encarga de medir cual es la cantidad 

de humedad que puede retener una cuenca, su rango es de 0 a 1, cuando los 

valores son más bajos significa que existe menor regulación y se halla de acuerdo 

a la siguiente formula (IDEAM, 2021, párr. 1). 

𝐼𝑅𝐻 =  
𝑉𝑝

𝑉𝑡
 

Vp: Volumen representado por el área que se encuentra por debajo de la 

línea de caudal medio. 

Vt: volumen total representado por el área bajo la curva de duración de 

caudales diarios. 

De acuerdo a ello se tiene los siguientes valores obtenidos a través de 

(INGEMMET, 2019, p. 222) 

𝐼𝑅𝐻 =  
4302.97

6024.85
 

𝐼𝑅𝐻 = 0.71 

De acuerdo a ello se tiene la siguiente tabla se tiene que el IRH es de 

capacidad de retención moderada. 

Tabla 7. Índice de regulación hídrica 

Descripción Valores 

Capacidad de retención muy baja < 0.5 
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Capacidad de retención baja 0.5 a 0.65 

Capacidad de retención moderada 0.65 a 0.75 

Capacidad de retención alta 0.75 a 0.85 

Capacidad de retención muy alta > 0.85 

Fuente: (IDEAM, 2021, párr. 1) 

5.9.1.2 Coberturas Reguladoras del ciclo hidrológico 

Según (MINAM, 2021, párr. 1) de acuerdo al mapa de cobertura vegetal 

actualizado la cuenca Moquegua posee las siguientes coberturas: 

Tabla 8. Coberturas vegetales de la cuenca Moquegua 

Cobertura vegetal Área (Km2) Porcentaje (%) 

Agricultura costera y andina 91.64 2.58 

Área altoandina con escasa y sin vegetación 405.02 11.42 

Área Urbana 5.36 0.15 

Bofedal 6.71 0.19 

Bosque relicto altoandino 6.79 0.19 

Cardonal 608.56 17.15 
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Centro minero 27.62 0.78 

Desierto costero 1690.16 47.64 

Glaciar 1.89 0.05 

Lagunas, lagos y cochas 0.38 0.01 

Matorral arbustivo 421.78 11.89 

Pajonal andino 280.88 7.92 

Plantación forestal 1.08 0.03 

TOTAL 100 

Fuente: Elaboración propia en base a datos obtenidos en ArcGIS 10.4 

De esta tabla se puede interpretar que las coberturas reguladoras del ciclo 

hidrológico son: Área urbana, centros mineros, agricultura costera y andina y 

plantación forestal, ya que según (Mendoza, et al., 2021, p. 1) las coberturas que 

influyen en el ciclo hidrológico son las que muestran una fuerte presión sobre el 

recurso hídrico por lo que repercute en su deterioro, principalmente por 

contaminación y reducción de suministro de agua superficial. 
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Figura 10. Coberturas vegetales de la cuenca Moquegua 

 

Fuente: Elaboración propia en ArcGIS 10.4 

Finalmente, el porcentaje de cobertura es de 3.54% y en unidades sería 

125.71 km2.  

5.9.1.3 Índice de Uso de Agua (IUA) 

De acuerdo al último censo en el 2017, la población de Moquegua dio como 

resultado un total de 174 mil 863 habitantes; la cual al compararla con la cantidad 

de habitantes del censo anterior a este (realizado en el año 2007), se encontró un 

aumento en la tasa de crecimiento anual de 2.0% en los habitantes de la zona 

urbana y una disminución de la tasa de crecimiento anual de 4.7% en la rural 

(Instituto Nacional de Estadística e Informática, 2018, p 24). 

Según el anuario de estadísticas ambientales el Perú dispone con un 

volumen anual promedio de 1 768 512 hectómetros cúbicos de agua, distribuidos 

en todas sus vertientes hidrográficas. Las cuencas de la región Moquegua, 
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pertenecen a la vertiente hidrográfica del pacifico, la cual cuenta con un promedio 

de 38 821 hectómetros cúbicos. 

El 75.0% de la población posee acceso de agua potable y de este solo 60.1% 

tiene acceso a agua con niveles de cloro adecuados (INEI, 2019 p- 20 y 27). Por 

otro lado, el IUA se refiere a un volumen usado de agua por todos los actores 

existentes en la cuenca en un tiempo determinado, es por ello que se relaciona la 

demanda de agua con la oferta hídrica. Para hallar este índice tenemos la siguiente 

fórmula:  

𝐼𝑈𝐴𝑗𝑡 = (
𝐷ℎ𝑗𝑡

𝑂ℎ𝑗𝑡
) 

Donde: 

𝐷ℎ𝑗𝑡 : Demanda hídrica sectorial en la unidad espacial de referencia (j), en 

un periodo determinado de tiempo. 

𝑂ℎ𝑗𝑡 Oferta hídrica superficial disponible en la unidad espacial de referencia 

(j), en un determinado periodo de tiempo. 

𝐷ℎ𝑗𝑡 93.336 

𝑂ℎ𝑗𝑡: 149.947 hectómetros cúbicos 

Datos extraídos de: (Alvarado J. D., 2016) 

𝐼𝑈𝐴𝑗𝑡 = (
93.336

149.947 
) 

𝐼𝑈𝐴𝑗𝑡 = 0.6224 

5.9.1.4 Índice de fragmentación 

(Jiménez, 2019 p. 37) habla de un cálculo al superponer la cobertura de la 

tierra con una cuadrícula de celdas, y la distribución entre los complejos naturales 

es evaluada dentro de esas celdas. De cada celda se determina cuántos complejos 

naturales se encuentran en ella. Según el tipo de cobertura en el área estudiada se 
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puede encontrar un área adyacente a las presiones y otra sensible a las mismas, y 

áreas que no caen en ninguno de esos dos aspectos, denominadas de carácter 

neutral. 

(Corredor, 2019, p. 39) El índice de fragmentación es calculado por medio 

de la aplicación de celdas de 2 x 2 km en un mapa de coberturas procesadas y se 

procede a realizar la siguiente fórmula: 

𝐼𝐹 =
𝑃𝑆𝐶

(
𝑃𝑆
𝐶𝑆)

16 𝑋
𝑃𝑆
16

 

De donde se entiende: 

IF: Índice de fragmentación  

PSC: Celdas conectadas sensibles  

PS: Celdas sensibles 

CS: Complejos sensibles 

Teniendo en cuenta que las celdas sensibles son aquellas que poseen un 

alto impacto de la mano del hombre lo que genera una presión en las áreas 

naturales y las celdas conectadas sensibles se pueden considerar aquellas 

infraestructuras que causen efectos barreras y fragmentación en las áreas 

naturales susceptibles. Los rangos que se establecen para determinar el índice de 

fragmentación son los siguientes: 

Tabla 9.  Valores del índice de Fragmentación  

VALOR DE FRAGMENTACIÓN RANGO 

Mínima  IF < 0,01 

Poca IF 0,01 - 0,1 
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Regular  IF 0,01 – 1 

Moderada IF 1 – 10 

Fuerte IF 10 – 100 

Extrema IF > 100 

Fuente: Corredor, 2019, p.40 
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Figura 11. Mapa de la cuenca Ilo- Moquegua y la ubicación de las celdas 

 

Fuente: Elaboración propia 

Luego de analizar el mapa de coberturas de la cuenca Ilo – Moquegua se realiza 

una superposición de casillas de 2x2 km de las cuales salen 3550 celdas de las 

cuales se puede identificar que las celdas sensibles en total serian 1430, las celdas 

conectadas sensibles serian 1125, y el número de complejos sensibles serian 305. 

Con un índice de fragmentación en nivel fuerte. 

𝐼𝐹 =
1430

(
1125
305 )

16
𝑋

1125
16

 

𝐼𝐹 = 88, 27 

5.9.1.5 Índice de calidad de agua 

(INGEMMET, 2019) realizó 3 campañas de campo para generar un 

inventario de 121 fuentes de agua, de las cuales 34 fueron muestreadas de forma 
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puntual y no de forma sistemática. Para este estudio se tuvo en cuenta la 

distribución aleatoria de las fuentes de agua repartidas a lo largo de toda la cuenca 

del río Ilo Moquegua, así como las características hidráulicas y litología variable 

según el lugar (INGEMMET, 2019 p. 117).  

(INGEMMET, 2019) indica que el análisis realizado fue de metales disueltos, 

este análisis indica el contenido y la cantidad de elementos en estado iónico, esto 

representa la composición química del agua subterránea. Este análisis consiste en 

usar iones mayoritarios (Ca, Na, Mg K HCO, CO, SO, Cl y NO3) y metales disueltos 

(Fe, As, Pb, entre otros), los cuales inciden en los metales pesados. 

Posteriormente se hizo un análisis del agua de los manantiales y pozos 

tomando así 22 muestras para conocer sus características isotópicas, llevando a 

cabo un análisis por isótopos ambientales (18𝑂 𝑦 𝐷) llevado a cabo en el laboratorio 

de isótopos ambientales en Chile. 

Tabla 10.  Parámetros de agua  

Parámetros 
Ríos De Costa Y 

Sierra 

Análisis De Las Cuencas Moquegua-

Ilo 

Fuente (El Peruano, 2017) (INGEMMET, 2019, p. 120)  

Temperatura Δ 3 13.57 

pH 6,5 a 9,0 7.61 

Ce <5000 523.24 

Fuente: (INGEMMET, 2019) 

El índice de calidad de agua califica de 0 a 100, desde muy mala, mala 

media, buena, excelente y según los estudios realizados y la comparación con la 

ECA (estándares de calidad ambiental) para el agua se encontró que el índice de 
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calidad de esta cuenca es 51.44, lo que indica que las aguas de estudiadas cuentan 

con calidad media (Alvarado, 2017). 

5.9.1.6 Precipitación y Temperatura 

En la recolección de información de temperatura y precipitación de los 

últimos 30 años se usó la plataforma del SENAMHI que contiene los datos 

hidrometeorológicos de las siguientes estaciones (SENAMHI, 2021, párr. 1): 

● Estación Hidrológica Convencional 

● Estación Hidrológica Automática 

● Estación Meteorológica Convencional  

● Estación Meteorológica Automática 

Las estaciones a usar están señaladas en la tabla 9. 

Tabla 11. Estaciones Meteorológicas a usar. 

N° Estación Descripción Ubicación 
Información 

extraída 

1 

Estación Ilo 

Código: 117007 

Tipo: 

Convencional 

Meteorológica  

Latitud 

17°37’25.7’’ S 

Longitud 

71°16’18.8’’ 

W 

Altitud: 60 

msnm 

Departamento: 

Moquegua 

Provincia: Ilo 

Distrito: El 

Algarrobal 

Precipitación, 

Humedad relativa, 

Temperatura 

máxima, 

Temperatura mínima 

De los años: 2017, 

2018, 2019, 2020 
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2 

Estación 

Moquegua 

Código: 

4723F1BE 

Tipo: 

Automática 

Meteorológica 

Latitud 

17°10’43.48’’ 

S 

Longitud 

71°55’57.61’’ 

W 

Altitud: 1420 

msnm 

Departamento: 

Moquegua 

Provincia: 

Mariscal Nieto 

Distrito: 

Moquegua 

Precipitación, 

Humedad relativa, 

Temperatura 

máxima, 

Temperatura 

mínima, velocidad 

del viento 

De los años: 2016, 

2017, 2018, 2019, 

2020 

3 

Estación 

Yacanco 

Código: 100150 

Tipo: 

Convencional 

Meteorológica 

Latitud: 

17°5’26.8’’ S 

Longitud: 

70°52’1.2’’ W 

Altitud: 2053 

msnm 

Departamento: 

Moquegua 

Provincia: 

Mariscal Nieto 

Distrito: Torata 

Precipitación, 

Humedad relativa, 

Temperatura 

máxima, 

Temperatura mínima 

De los años: 2018, 

2019, 2020 

Fuente: Elaboración propia a partir de (SENAMHI, 2021, párr. 1)  

Como no existe información completa de los datos que se requieren para el 

trabajo de investigación se optó por la herramienta NASA POWER, la NASA, ha 

apoyado durante mucho tiempo la investigación y los sistemas de satélites, 

proporcionando información importante en el estudio de los procesos climáticos y 

del clima. Esta información incluye estimaciones climatológicamente promediadas 

a largo plazo de cantidades meteorológicas y flujos de energía solar superficial 

(NASA POWER, 2021, párr. 9). 

Gracias a los datos que se obtuvieron de la NASA se pudo completar la 

información faltante de cada estación. Los datos que se consideraron fueron: 
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Temperatura mínima, temperatura máxima, temperatura promedio, humedad 

relativa, precipitación y dirección del viento. 

5.9.1.7 Caudal 

5.9.1.7.1 HEC-HMS 

Este es un programa que logra simular el hidrograma de una cuenca 

mediante aquellos datos físicos que la misma cuenca posee, logrando estimar 

aquellos caudales máximos que son generados en tiempos de circunstancias pico 

en los que hay presencia de lluvias extremas. Además de todo gracias a cálculos 

de hietogramas de diseño genera cálculos del flujo base, pérdidas de infiltración y 

la conversión a escorrentía directa (García, 2015, p. 36). 

Este programa se usará para simular el caudal histórico de la cuenca 

Moquegua. En la tabla 12 se tienen dos estaciones hidrológicas del SENAMHI, sin 

embargo, estas estaciones no tienen información de los caudales de la cuenca, es 

por ello que se usará las coordenadas de estas estaciones para simular los 

caudales. 

Tabla 12. Estaciones Hidrológicas a usar 

N° Estación Descripción Ubicación 
Información 

extraída 

1 

Estación 

Tumilaca 

Código: 204804 

Tipo: 

Convencional 

Hidrológica 

Latitud: 

17°7’42.2’’ S 

Longitud: 

70°7’42.2’’ W 

Altitud: 1929 

msnm 

Departamento: 

Moquegua 

Provincia: 

Mariscal Nieto 

Distrito: Torata 

Solo tiene 

información de nivel 

de río, pero no de 

velocidad por lo que 

no se puede calcular 

caudales, pero se 

tomará como punto 

de referencia. 
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2 

Estación Otora 

Código: 214700 

Tipo: 

Convencional 

Hidrológica 

Latitud: 

17°0’26.36’’ S 

Longitud: 

70°51’12.99’’ 

W 

Altitud: 2575 

msnm 

Departamento: 

Moquegua 

Provincia: 

Mariscal Nieto 

Distrito: Torata 

Solo tiene 

información de nivel 

de río, pero no de 

velocidad por lo que 

no se puede calcular 

caudales, pero se 

tomará como punto 

de referencia. 

Fuente: Elaboración propia a partir de (SENAMHI, 2021, párr. 1) 

De acuerdo a lo obtenido se tienen dos valores para los caudales promedio 

para los puntos elegidos: 

Tabla 13. Valores de los caudales 

N° Estación Caudal (m3/s) 

1 Estación Tumilaca 0.5  

2 Estación Otora 10 

Fuente: Elaboración propia 
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Figura 12. Hidrograma de la cuenca Moquegua 

 

Fuente: HEC HMS 

Interpretación: A través de la tabla 13 se aprecia que los dos caudales calculados 

en la cuenca pertenecen a dos estaciones hidrológicas, y son un promedio obtenido 

a través del programa, por otro lado, se observa que estos caudales promedio son 

bajos, esto se debería principalmente a las bajas precipitaciones presentadas en la 

cuenca, además de que de acuerdo a (INGEMMET 2019, p. 54) esta cuenca ha 

sufrido de constantes sequias entre los años 1971 hasta 1991, lo que no le permitía 

cubrir la demanda hídrica de la población, ya que anteriormente su utilizaba agua 

subterránea de pozos, hasta que en el año 1996 a través del proyecto Pasto Grande 

se pudo trasvasar las aguas superficiales de la CH alta del rio Tambo, por lo que 

se ha cubierto el déficit de agua y se incrementó la disponibilidad hídrica, lo que 

permitió usar aguas superficiales para regadío, así como en otras industrias, por lo 

que el caudal de la cuenca es alterado constantemente, además se observa en el 

grafico 13 que la cuenca no ha presentado caudales mayores a 30 m3/s, luego el 

promedio general de la cuenca sería de 5m3/s de acuerdo a lo obtenido, esto se 

podría comparar con los valores obtenidos por INGEMMET de acuerdo a diversas 

instituciones: 
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Tabla 14 Caudales de la cuenca Ilo Moquegua obtenido por otras instituciones 

ONERN ANA CEDEX ELECTROPERÚ 

PROMEDIO 

ANUAL 

SENAMHI 

2.87 m3/s 2.13 m3/s 1.8 m3/s 4.3 m3/s 2.78 m3/s 

Fuente: (INGEMMET, 2019, p. 64) 

Figura 13. Mapa de las estaciones a usar 

 

Fuente: (SENAMHI, 2021, párr. 1) 

Luego, los resultados obtenidos, de la base de datos del SENAMHI y la base 

de datos de NASA POWER se pueden resumir en las siguientes tablas, y fue 

obtenido realizando un promedio de la data por año. 
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Tabla 15. Datos meteorológicos de la estación Ilo 

Año 
Precipitaci

ón 

Humeda

d 

Relativa 

Temperatur

a Mínima 

Temperatur

a Máxima 

Velocidad 

del viento 

1990 0.01 74 20.25 24.62 3.29 

1991 0.02 80.69 13.5 18.04 3.44 

1992 0 76.12 13.21 18.05 3.06 

1993 0 75.22 14.12 20.26 3.32 

1994 0 79.49 14.72 19.65 3.16 

1995 0 80.84 14.16 19.08 2.43 

1996 0 78.08 16.37 22.2 4.15 

1997 0 77.41 18.25 23.36 3.66 

1998 0.04 77.36 15.05 20.75 3.91 

1999 0.01 78.19 16.22 21.19 3.69 

2000 0.01 76.64 18.43 23.09 3.93 

2001 0 79.87 12.79 17.91 3.92 

2002 0 81.48 17.76 21.75 3.48 

2003 0 78.94 17.77 22.83 3.17 

2004 0 77.79 13.58 18.52 2.94 

2005 0 77.08 14.24 18.6 2.47 

2006 0 74.94 16.15 21.27 2.55 

2007 0 77.58 16.96 21.52 4.79 

2008 0.01 78.04 20.99 25.13 3.53 

2009 0 76.53 14.67 19.2 3.99 

2010 0 77.59 15.1 19.9 3.25 

2011 0.01 74.16 19.19 24.38 3.92 

2012 0 76.88 17.56 23.17 3.02 

2013 0.23 79.29 20.53 25.48 3.04 

2014 0 78.72 19.26 24.2 3.08 

2015 0.03 80.47 18.6 22.89 4.12 

2016 0 74.11 15.84 22.36 2.66 
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2017 0.01 82.51 17.04 26.51 4.05 

2018 0.00 85.03 16.98 26.42 2.44 

2019 0.00 87.24 16.70 26.49 2.78 

2020 0.02 88.69 21.57 31.75 4.21 

Fuente: Elaboración propia a partir de (NASA POWER, 2021) y (SENAMHI, 2021) 

 

Figura 14. Precipitación anual de la estación Ilo (1990 – 2020) 

 

Fuente: Elaboración propia 
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Figura 15. Temperatura anual de la estación Ilo (1990 – 2020) 

 

Fuente: Elaboración propia 

Interpretación: La estación Ilo que se encuentra en la parte baja de la cuenca 

presenta precipitaciones bajas en un rango de 0 a 0.25 mm, siendo su pico más 

alto en los años 2012 y 2014, de acuerdo a (INGEMMET 2019, p. 54) durante los 

años 1971 a 1991 se registró una sequía continua hasta la construcción de Pasto 

Grande, que alimenta el caudal de la cuenca, sin embargo, se observa que las 

precipitaciones continúan siendo bajas en la cuenca, estas bajas precipitaciones 

concordarían con lo señalado por (INGEMMET 2019, p. 55) que refiere que las 

precipitaciones en la parte baja en entre el litoral marino y los 2500 msnm s el sector 

menos lluvioso de toda la cuenca, pues esta influenciado por una elevada 

concentración de neblinas invernales que provienen del Pacifico de mayo a 

septiembre, por otra parte la temperatura promedio anual no varía fuertemente, se 

observa que tiene un comportamiento estable con un ligero incremento durante los 

últimos años debido probablemente al CC. 
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Tabla 16. Datos meteorológicos de la estación Moquegua 

Año 
Precipitaci

ón 

Humeda

d 

Relativa 

Temperatur

a Mínima 

Temperatur

a Máxima 

Velocidad 

del viento 

1990 0.03 77.19 18.96 23.43 3.37 

1991 0.01 79.62 19.71 24.7 3.21 

1992 0.34 79.33 18 23.23 3.94 

1993 0.04 73.8 18.82 23.29 3.45 

1994 0.12 80.74 16.64 20.94 2.98 

1995 0 74.98 14.47 18.83 2.79 

1996 0.01 78.81 17.63 22.68 2.97 

1997 0 78.25 16.04 20.9 3.77 

1998 0 79.89 15.16 19.57 3.23 

1999 0.04 78 15.05 19.86 3.3 

2000 0 73.53 15.95 20.96 2.68 

2001 0.06 82.2 19.83 24.21 3.15 

2002 0 73.61 15.73 21.59 3.69 

2003 0.02 76.5 20.92 25.35 3.7 

2004 0 75.73 19.41 23.98 3.67 

2005 0 74.47 15.85 20.75 3.04 

2006 0 71.83 13.53 18.98 3.2 

2007 0 76.42 16.41 20.47 3.39 

2008 0 70.51 12.25 18.05 3.71 

2009 0 71.19 13.3 18.91 2.66 

2010 0 76.24 17.25 21.72 3.65 

2011 0 71.1 14.62 18.62 2.28 

2012 0 77.19 15.01 19.8 2.49 

2013 0 74.25 15.23 20.05 2.23 

2014 0 72.91 16.54 21.15 2.58 

2015 0 68.43 14.8 20.67 3.28 

2016 0 77.16 17.56 22.45 2.53 
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2017 0 80.59 18.46 23.2 3.19 

2018 0 76.23 18.03 23.08 2.42 

2019 0 76.57 17.94 22.97 3.33 

2020 0.06 79.34 17.17 21.78 3.1 

Fuente: Elaboración propia a partir de (NASA POWER, 2021) y (SENAMHI, 2021) 

 

Figura 16. Precipitación anual de la estación Moquegua (1990 -2020) 

 

Fuente: Elaboración propia 
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Figura 17. Temperatura anual de la estación Moquegua (1990 -2020) 

 

Fuente: Elaboración propia 

Interpretación: La estación Moquegua que se encuentra en la parte media de la 

cuenca, se observa por la tabla 16 y los gráficos obtenidos de esta que, 

primeramente el rango de precipitaciones se ha incrementado, es decir, de 0 a 0.4 

mm, por otro lado, se aprecia que el mayor pico alcanzado fue en el año 1992, 

hasta que en el 2004 se observa que las precipitaciones fueron prácticamente 

nulas, por lo que es cierto que existe un incremento de precipitación conforme se 

sube de altura, pero no parece ser muy significativo, de igual forma la temperatura 

presenta ligeras variaciones pero no son muy significativas, (INGEMMET, 2019, p. 

58) señala que de acuerdo al piso altitudinal es que la temperatura a lo largo de la 

cuenca presenta ligeras variaciones, pero estas no son muy significativas, y que las 

mayores temperaturas se presentan durante la época de verano (enero, febrero y 

marzo) y los otros meses, presenta las bajas temperaturas que se registran (junio, 

julio y agosto) y de igual forma con respecto a la precipitación. 
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Tabla 17. Datos meteorológicos de la estación Yacanco 

Año 
Precipitaci

ón 

Humeda

d 

Relativa 

Temperatur

a Mínima 

Temperatur

a Máxima 

Velocidad 

del viento 

1990 0 78.64 19.24 23.95 3.97 

1991 0 74.9 19.83 24.38 4.06 

1992 0 68.45 12.97 18.88 2.91 

1993 0 74.55 19.41 24.33 3.69 

1994 0 74.23 15.54 20.77 2.59 

1995 0.01 80.8 14.79 19.74 3.26 

1996 0 76.9 19.35 24.3 3.49 

1997 0.02 78 18.68 23.01 4 

1998 0.01 73.37 15.53 20.74 3.97 

1999 0 74.36 15.46 20.84 4.09 

2000 0.08 82.26 19.52 22.3 3.8 

2001 0.11 79.73 20.52 25.28 2.97 

2002 0.1 80.93 20.01 24.15 3.78 

2003 0.05 78.53 18.61 23.37 4.16 

2004 0.04 77.26 19.1 23.73 3.3 

2005 0 74.91 13.99 18.82 4.32 

2006 0.04 81.05 20.05 24.07 3.37 

2007 0.01 78.68 17.02 22.03 3.31 

2008 0.01 74.28 17.55 22.92 3.2 

2009 0 71.19 13.3 18.91 2.66 

2010 0.01 74.16 15 20.8 3.51 

2011 0.03 71.62 13.23 18.83 3.34 

2012 0 78.42 14.78 19.58 3.7 

2013 0 76.04 14.5 19.38 3.63 

2014 0 76.02 18.56 23.6 3.24 

2015 0 74.82 13.7 19.01 3.34 

2016 0 76.45 15 19.85 3.09 
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2017 0.01 79.98 20.97 25.21 3.32 

2018 0.03 71.80 11.10 25.16 3.37 

2019 0 76.08 14.37 19.03 3.05 

2020 0.06 80.8 17.31 21.23 3.09 

Fuente: Elaboración propia a partir de (NASA POWER, 2021) y (SENAMHI, 2021) 

Figura 18. Precipitación anual de la estación Yacanco (1990-2020) 

 

Fuente: Elaboración propia 
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Figura 19. Temperatura anual de la estación Yacanco (1990-2020) 

 

Fuente: Elaboración propia 

Interpretación: La estación Yacanco, que se encuentra en la parte alta de la 

cuenca a pesar de no registrar altas precipitaciones si muestra que en esta zona 

existe mayor precipitación que en las otras estaciones, en general todos los años, 

esto según (INGEMMET, 2019, p. 54) debido a que en la zona alta de Puna aún 

existen porciones pequeñas de nevados, la temperatura continúa siendo estable, 

presentando variaciones relativamente estables.  

Con todo ello se observa que las precipitaciones son menores a la 

temperatura todos los años, por lo que esto contribuye al déficit hídrico de la 

cuenca, por otro lado, respecto a la humedad relativa se observa que en todas las 

tablas tiene un valor no muy variable, siendo que el valor promedio de esta es de 

acuerdo a las tablas de 75.86% y la dirección del viento con un promedio general 

de 3.33 m/s, (INGEMMET, 2019, p. 61) indica que los valores más altos de viento 

ubicados en la parte baja de la cuenca y a medida que la altura aumenta, la 

velocidad del viento disminuye. 
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5.9.2 Político institucional 

5.9.2.1 Inversiones del acueducto en gestión ambiental para la cuenca 

Según (Corporación ANP, 2016) para hallar este indicador es necesario 

aplicar la siguiente fórmula: 

%𝐼𝑛𝑣𝑒𝑟𝑠𝑖𝑜𝑛𝑒𝑠 =  
𝐾

𝑇
∗ 100 

Donde: 

K: Número de proyectos financiados 

T: Número de proyectos formulados 

De acuerdo a (Zavaleta, 2017, p. 5) la cuenca del río Moquegua no tiene 

regulación en toda la cuenca, pero recibe descargas de caudales regulados del 

Canal de Pasto Grande, uno de los proyectos de inversión más importantes de la 

cuenca, de donde las aguas son derivados de la cuenca del río Tambo. Para hallar 

el porcentaje de inversiones del acueducto se enumeran a continuación los 

proyectos que se encuentran en la cuenca Moquegua de acuerdo con lo que indica 

(Alegría, 2016, p.9): 

● Proyecto Infraestructura Natural para la Seguridad Hídrica 

● Proyecto Especial Regional Pasto Grande (PERPG) 

● Programa de Formalización de Derechos de Usos de Agua (PROFODUA) 

● Programa de Encauzamientos de Ríos y Protección de Estructuras de 

Captación (PERPEC) 

● Programa Sectorial de Irrigación (PSI) 

● Fondo de Cooperación para el Desarrollo Social (FONCODES) 

Todos estos proyectos están Financiados por lo que el indicador sería del 

100% 
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5.9.2.2 Actores relacionados con el recurso hídrico en la cuenca 

Según (Alegría, 2016, p.9) los actores de la gestión del agua se organizan 

en tres grupos de acuerdo a la siguiente tabla: 

Tabla 18. Actores relacionados a la cuenca Moquegua 

Actores Descripción 

Gestión social: 

Conformado por organizaciones 

de usuarios locales, relacionados 

directamente a su utilización, 

agrario o poblacional y que 

puedan gestionar el agua acorde 

a sus costumbres y usos, valoran 

el agua por sus criterios 

económico, cultural, social y 

también religioso 

1. Comunidades campesinas ubicadas 

en zonas andinas de la cuenca. 

2. Comisiones, juntas de Usuarios y 

comités de regantes, ubicados en 

zonas de valle y costeras, que 

administran y operan infraestructuras 

menores de riego. 

3. Juntas de servicios de agua y 

saneamiento o comités de agua 

potable, que mantienen y operan el 

servicio de agua en algunos centros 

poblados pequeños. 

4. Asociaciones civiles, con objeto de 

promocionar la incidencia en 

contribución a objetivos de gestión 

del agua. 

Gestión empresarial:  

Realizada por iniciativas de 

agencias y empresas 

económicas privadas con fines 

de lucro o la óptima prestación de 

servicios públicos que 

desempeñan en un marco de 

1. Empresas Mineras (Southern Perú 

Copper Corp, SPCC, Anglo 

American Quellaveco, AAQ) 

2. Empresas agropecuarias 

3. Empresas prestadoras de 

saneamiento municipales. 

4. Empresas prestadoras de 

electricidad (SPCC y ENERSUR) 
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formalidad, consideran el agua 

como un insumo de producción 

Gestión pública del agua:  

La cual la asumen las 

instituciones públicas con un 

mandato normativo o técnico 

normativo determinado 

relacionado a la gestión del agua 

en concordancia al marco 

institucional y normativo del 

agua. 

1. ANA: Calidad de ente rector 

2. ALA Moquegua: con jurisdicción en 

la cuenca Ilo - Moquegua y el sector 

del Alto Tambo del ámbito de 

influencia de la Presa Pasto Grande, 

trasvasado a Moquegua 

3. MINAM: Ente rector de la gestión 

ambiental 

4. Gobierno regional 

5. Instancias regionales de los sectores 

públicos 

6. Gobiernos locales 

7. Programas y proyectos del estado 

Total 15 

Fuente: (Alegría, 2016, p. 11) 

5.9.3 Económico productivo 

En esta dimensión se puede analizar el desarrollo socioeconómico con la 

realización de diferentes actividades económicas como podrían ser pecuario, 

forestal, cacería, agricultura, apicultura, crianza de animales domésticos, uso de 

recurso hídrico y minería no metálica. Además, también pueden analizarse la 

promoción y desarrollo de asociaciones con cadenas productivas, mejoramiento de 

red vial regional con prioridad de promover el desarrollo de las actividades que la 

cuenca puede promover (GRM, 2018, p. 56). 

5.9.3.1 % Cobertura acueducto rural 

Es el porcentaje del sistema de abastecimiento de agua, en el caso del 

acueducto de la zona rural es aquel sistema utilizado para abastecer a la zona rural. 
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Figura 20. Cobertura rural peruana 

 

Fuente: Ministerio de Vivienda, Construcción y Saneamiento, 2019, p.8 

5.9.3.2 % Cobertura acueducto urbana 

Es el porcentaje del sistema de abastecimiento de agua, en el caso del 

acueducto urbano es aquel sistema utilizado para abastecer a la zona urbana. 
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Figura 21. Cobertura urbana peruana 

 

Fuente: Ministerio de Vivienda, Construcción y Saneamiento, 2019, p.8 

5.9.4 Socio cultural 

En esta dimensión se pueden analizar los factores de conflictos de usos de 

agua, la disponibilidad del agua de la comunidad, densidad de la población, niveles 

de organización, calidad de vida, pobreza entre otros. Además, también se busca 

con el análisis de esta dimensión de que la población participe en sus aspiraciones 

respecto al plan del uso del agua en lo posible y puedan obtener algún beneficio 

(CEPAL, 2018, p.10). 
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5.9.4.1 Densidad poblacional rural 

Este indicador evalúa el nivel de concentración de la población en una región 

determinada, en este caso se evaluará para el área geográfica de influencia de la 

cuenca Moquegua, es el número de habitantes que existen en un kilómetro 

cuadrado, en este caso hablando de población en el área rural (INEI, 2017, p. 20). 

Población censada 2017: 22 972 - 13,1% 

Superficie en km2: 15 734 

Su densidad sería: 1,46 hab/km2 

5.9.4.2 Densidad poblacional urbana 

Este indicador estima el nivel de concentración de la población en una región 

determinada, en este caso se evaluará para el área geográfica de influencia de la 

cuenca Moquegua, es el número de habitantes que existen en un kilómetro 

cuadrado, en este caso hablando de población en el área urbana (INEI, 2017, p. 

20). 

Población censada en 2017: 151 891 - 86.9% 

Superficie en km2: 15 734 

Su densidad sería: 9,65 hab/km2 

5.9.4.3 Percepción de eficiencia del servicio de acueducto usuarios zona 

urbana 

Según (EPS Moquegua S.A., 2019, p. 18) este indicador evalúa el porcentaje 

de eficiencia del servicio de acueducto que se presta en la zona urbana del área 

influenciada por la cuenca Moquegua, teniendo un porcentaje de 75,9%. 
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5.9.4.4 Percepción de eficiencia del recurso hídrico por usuarios zona rural 

Según (EPS Moquegua S.A., 2019, p. 18) este indicador evalúa el porcentaje 

de eficiencia del recurso hídrico que se presta en la zona rural del área influenciada 

por la cuenca Moquegua, teniendo un porcentaje de 59 %. 

Tabla 19. Resumen de los indicadores 

Dimensión Indicadores Valor (x) Fuente 

bibliográfica 

Biofísica Índice de regulación hídrica 0,71 (IDEAM, 2021) 

Coberturas Reguladoras del 

ciclo hidrológico 
3,54% (MINAM, 2021) 

Índice de Uso de Agua 0,6224 (Alvarado, 2017) 

Índice de fragmentación 88,27 (Jiménez, 2019) 

Índice de calidad de agua 51,44 (Alvarado, 2017) 

Precipitación 
0,018 

mm 

(SENAMHI, 2021) 

(NASA POWER, 

2021) 

Caudal 5 m3/s 

Temperatura 
19,207 

°C 

(SENAMHI, 2021) 

(NASA POWER, 

2021) 

Político 

institucional  

Inversiones del acueducto en 

gestión ambiental para la 

cuenca 

100% (Alegría, 2016) 

Actores relacionados con el 

recurso hídrico en la cuenca 
15 (Alegría, 2016) 

Económico 

productivo 

% Cobertura acueducto rural 91,03 % 

(Ministerio de 

Vivienda, 

Construcción y 

Saneamiento, 

2019) 
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% Cobertura acueducto 

urbana 
99,86 % 

(Ministerio de 

Vivienda, 

Construcción y 

Saneamiento, 

2019) 

Socio 

cultural 
Densidad poblacional rural  

1,46 

hab./km2 

(INEI, 2017) 

Densidad poblacional urbana 
9,65 

hab./km2 

(INEI, 2017) 

Percepción de eficiencia del 

servicio de acueducto 

usuarios zona urbana. 

75,9% 

(EPS Moquegua 

S.A., 2019) 

Percepción de eficiencia del 

recurso hídrico por usuarios 

zona rural. 

59% 

(EPS Moquegua 

S.A., 2019) 

Fuente: Elaboración propia 

 

5.10 Paso 4: Fórmula para el análisis de la vulnerabilidad 

Aplicando la fórmula de para el análisis de la vulnerabilidad se tiene: 

𝑉 = 𝑒𝑥 + 𝑠𝑒 − 𝑐𝑎 +
1

3
                                                           (1) 

Luego procederemos al cálculo de cada uno de los componentes (ex, se, ca) 

de acuerdo con la metodología: 

En el caso de la vulnerabilidad presente  

𝑒𝑥 =  ∑𝑛
𝑖=1 𝐼𝑖 =  𝐼(𝑝1)(𝑤1) + 𝐼(𝑝2)(𝑤2) + 𝐼(𝑝3)(𝑤3) + 𝐼𝑛 = 0,94               (2) 

𝑠𝑒 =  ∑𝑛
𝑖=1 𝐼𝑖 =  𝐼(𝑝1)(𝑤1) + 𝐼(𝑝2)(𝑤2) + 𝐼(𝑝3)(𝑤3) + 𝐼𝑛 = 0.19               (3) 

𝑐𝑎 =  ∑𝑛
𝑖=1 𝐼𝑖 =  𝐼(𝑝1)(𝑤1) + 𝐼(𝑝2)(𝑤2) + 𝐼(𝑝3)(𝑤3) + 𝐼𝑛 = 1.25               (4) 
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Según la metodología que se está utilizando la vulnerabilidad tiene seis 

valores de interpretación equidistante: 

Figura 22. Rangos para la interpretación de la vulnerabilidad 

 

      

0                0.16              0.33               0.50              0.67            0.84                 1 

Muy bajo Bajo Medio bajo Medio alto Alto Muy alto 

Fuente: (Valencia, et al., 2016, p. 36) 

5.11 Paso 5: Evaluación de la vulnerabilidad actual y futura 

Tabla 20. Vulnerabilidad de acuerdo a los escenarios 

Escenarios S E CA V VULNERABILIDAD 

Presente 0.19 0.94 1.25 0.21  X     

Niño moderado 0.96 0.19 1.25 0.23  X     

Niña moderada 1 0.19 1.25 0.34   X    

Niño moderado 

BCA 

0.98 0.17 0.99 0.49   X    
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Fuente: Elaboración propia 

Interpretación: Se puede identificar que en la tabla 20 que los niveles de 

vulnerabilidad obtenidos luego del análisis de cada identificador y la aplicación de 

niveles de sensibilidad, exposición y capacidad adaptativa en cada uno de los 

escenarios planteados, en los que se puede identificar niveles de bajo en el 

presente, niño moderado, niño moderado ACA, niña moderada ACA; medio bajo en 

la niña moderada y niño moderado BCA; además de nivel medio alto para niña 

moderada BCA. De estos niveles de vulnerabilidad el que encontramos que puede 

representar un riesgo para esta cuenca serían el escenario que se dan en el nivel 

medio alto en el escenario niña moderada BCA.  

5.12 Propuesta de estrategias para afrontar el cambio climático en la cuenca 

Moquegua 

5.12.1 Misión 

Se proponen estrategias para poder afrontar la vulnerabilidad medio alta 

encontrada en la cuenca Moquegua en diferentes escenarios analizados y poder 

hacer frente al cambio climático. 

Niña moderada 

BCA 

1 0.17 0.98 0.52    X   

Niño moderado 

ACA 

0.91 0.25 1,29 0.18  X     

Niña moderada 

ACA 

0.91                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 0.25 1,29 0.19  X     
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5.12.2 Visión 

Esta propuesta de estrategias busca hacer frente a las situaciones de 

cambio climático que inciden de una u otra manera en el manejo del recurso hídrico 

de la cuenca Moquegua. 

5.12.3 Objetivos 

Proponer estrategias para poder hacer frente a los cambios climáticos en la 

cuenca Moquegua 

● Identificar las fortalezas del manejo de la cuenca Moquegua frente al 

CC. 

● Identificar las oportunidades del manejo de la cuenca Moquegua 

frente al CC. 

● Identificar las debilidades del manejo de la cuenca Moquegua frente 

al CC. 

● Identificar las amenazas del manejo de la cuenca Moquegua frente al 

CC. 
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5.12.4 Análisis FODA 

 

Fuente: Elaboración propia 

5.12.5 Estrategias 

● Mantener y organizar mesas de diálogo regional. 

● Intentar incorporar a todas las comunidades que están en el entorno 

de incidencia de la cuenca Ilo - Moquegua en las mesas de diálogo. 

● Realizar mayor inversión por parte de gobiernos nacionales y 

regionales poniendo como prioridad el diseño y la construcción de 

represas, ya que la cuenca Ilo - Moquegua no cuenta con ellas, para 

lograr regular y controlar el agua teniendo en consideración el Plan 

Estratégico de desarrollo nacional. 

● La generación de institucionalidad del manejo de la cuenca Ilo - 

Moquegua para hacer frente al cambio climático, no pueden 

alcanzarse con entes autárquicos con poca articulación ni capacidad 

organizacional en el trabajo y convergencia de intereses. 

 

 

Fortalezas 

Las condiciones actuales de la cuenca, una 
vulnerabilidad que se puede manejar y el 

apoyo de la dimensión social  

Oportunidades 

La realización de este proyecto identificando 
la vulnerabilidad de esta cuenca y así poder 

proponer acciones o estrategias para 
afrontar el cambio climático 

 Amenazas 

1 de los 7 escenarios de cambio climático  
planteados en el presente proyecto, que 

afectarían la gestión integrada de la cuenca 

 
Debilidades 

Niveles de vulnerabilidad medio alto en 1 de 
los 7 escenarios de cambio climático, 

Desinterés de parte de las autoridades en la 
gestión de la cuenca 

 FODA 
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● Realizar más propuestas para los acuerdos y puntos de vista que se 

puedan presentar en las mesas de diálogo exactamente en los 

debates que realizan, por medio de radiales e impresos, tratando de 

que no tenga influencia en los grupos ciudadanos anti desarrollo. 

● Tratar de que la Mesa de Diálogo no se politice mediante el 

planteamiento de normas que plasmen que los diálogos y debates 

sean técnicos, además que los acuerdos que se tomen sean en 

consenso. 

● Establecer en la Mesa de Diálogo, sobre todo en los integrantes, que 

el Estado tiene las instancias y unidades competentes que opinarán 

y resolverán técnicamente los aspectos o temas que se requieran o 

soliciten sus equipos técnicos. 

● Debe haber participación ciudadana democrática de la región para 

una previa consulta del otorgamiento de la licencia social. 

● Tener claro que las inversiones y estrategias políticas de desarrollo 

nacional y con otros fines están dentro de las competencias del 

gobierno nacional el cual podrá determinar el beneficio de las 

mayorías y el valor de la inversión nacional que se pueda realizar. 

● En estas mesas de diálogos la presencia de representantes de 

organizaciones desfasadas e ideologizadas representaran un bache 

en la toma de decisiones y esto lo deben tener claro las autoridades 

de las mismas, ya que podrían generar caos e inestabilidad social 

usando medios de comunicación aprovechando el autoritarismo y 

fanatismo para imponer sus puntos de vista. 

● En el caso del control y evaluación de la calidad del agua y su 

disponibilidad se debe instrumentar mecanismos integradores. 

● El uso conjunto y la gestión multisectorial de las aguas subterráneas 

y superficiales debe ser implementado y consolidado. 
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● La infraestructura mayor hidráulica debe ser consolidada. 

● Para el desarrollo de infraestructura en la gestión de agua se debe 

promocionar inversiones privadas. 

● Para el uso conjunto del agua subterránea y superficial se recomienda 

un modelamiento previo. 

● En el caso de la gestión de embalses también se recomienda un 

previo modelamiento. 

● Para formular planes de gestión del manejo del recurso hídrico de la 

cuenca se deben diseñar previamente procesos participativos. 

● Se debe considerar previamente para desarrollar proyectos 

hidráulicos de común aprovechamiento el diseño e implementación 

de un sistema financiero sólido. 

● En el caso de los programas binacionales de recursos hídricos deben 

ser gestionados previamente. 

● Para facilitar la solución de conflictos que se puedan presentar se 

debe plantear un vademécum normativo para casos especiales. 

● Para el caso de las aguas subterráneas presentes se debe diseñar e 

implementar sistemas de monitoreo. 

● En torno a los cuerpos de agua en calidad y cantidad se debe 

programar un monitoreo sistemático. 

● Para sedimentos en el recurso hídrico se debe programar su medición 

de manera sistemática. 

● Por último, en el caso de embalses de regulación se recomienda 

efectuar levantamientos batimétricos frecuentes. 
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V. DISCUSIÓN 

Se logro analizar los parámetros de precipitación con un valor en el rango de 0 a 

26 mm y la precipitación promedio que fue 0.18 mm, temperatura siendo el mínimo 

11 °C y el máximo 27 °C y la temperatura promedio es 19.2 y caudal promedio que 

fue de 0.5 a 10 y el promedio 5 m3/s, esto , esto mediante fuentes bibliográficas 

confiables como la base de datos meteorológicos del SENAMHI y la base de datos 

de la NASA, de donde se analizaron datos históricos de aproximadamente 30 años 

y se pudieron procesar de manera efectiva además del software HEC-HMS, de 

donde se obtuvieron los datos de caudal, para ello se promediaron los datos de 

cada día, de todos los años y se obtuvo un promedio general para cada año, este 

método de cálculo resultó eficiente pues los valores obtenidos concuerdan con el 

boletín hidrológico elaborado por el INGEMMET para el año 2019, pues indica 

valores bastante cercanos, todo ello con la finalidad de analizar la vulnerabilidad 

ante el CC y gestionar esto con las estrategias propuestas. 

De los resultados se observa que la cuenca sufre de estrés hídrico, y que 

para poder cumplir los requerimientos y la demanda hídrica es necesario 

incrementar su caudal a través de la represa Pasto Grande, esto corroborado con 

(INGEMMET, 2019, p. 56) quien sugiere que como solución a esta dependencia de 

la cuenca del rio tambo se enfoque en propuestas de intervención para incrementar 

la oferta hídrica a través del uso de los recursos subterráneos, además de que 

sugiere la captación de agua a través de neblina, por otra parte (ANA, p. 120) de 

acuerdo a su estudio hidrogeológico en la cuenca señala que existen 24 sectores 

de la cuenca con buenas condiciones de explotación de agua subterránea, esto 

reforzaría el hecho de que se puede trabajar de con los recursos subterráneos, pero 

no sin olvidar que es necesario considerar su manejo sostenible. 

Respecto a la vulnerabilidad, se realizó el análisis de esta, por lo que se 

definieron valores estándares en las dimensiones político institucional, económico 

productivo y socio cultural demostrando que la cuenca hidrográfica Ilo – Moquegua 

se da abasto en lo que cabe a la cobertura que puede dar a nivel social en la 

influencia de la cuenca, ya que son categorizadas según los componentes de 

vulnerabilidad que se están tomando en cuenta como son la exposición, capacidad 
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adaptativa y sensibilidad que se miden, que pueden diferir de otros componente 

tomados para el análisis de otras cuencas como se considera en (Mussetta, y otros, 

2017, p. 4) en la que se señalan dimensiones politicas, sociales, economicas y 

culturales que condiciona el analisis de vulnerabilidad mediante factores fisicos y 

sociales, ademas de que se sigue con las dimensiones tomadas en cuenta en la 

investigacion (Valencia, et al., 2016, p. 5), en la que se definen estas dimensiones 

por el modelo AVA que se utiliza como referencia. 

Del análisis de vulnerabilidad se obtuvieron los valores de vulnerabilidad en 

los escenarios de niña moderada BCA son de 0.52, encajando en el nivel medio 

alto de vulnerabilidad, en el caso de niña moderada es de 0,34 y en el caso del niño 

moderado BCA es de 0,49 valores que indican que tienen un nivel de vulnerabilidad 

medio bajo y en el caso de los escenarios del presente con 0,21; niño moderado 

0.23; niño moderado ACA 0.18 y niña moderada ACA 0.19 el nivel de vulnerabilidad 

es bajo. Teniendo en cuenta que se encontraron situaciones de emergencia 

declarando peligro inminente en el periodo de lluvias 2019-2020 en la cuenca 

hidrográfica Ilo – Moquegua según (ANA, 2020, párr. 4), ademas tambien se 

evaluan puntos criticos, en la cuenca, pero no hay estudios que puedan contrastar 

los niveles de vulnerabilidad, según (INGEMMET, 2019, p. 166) se identifican 

tambien niveles de vulnerabilidad en la cuenca Ilo – Moquegua con valores de 0,64 

y 0,56 en acuiferos sedimentarios, ante la contaminacion que se presenta en el 

área, delimitando la vulnerabilidad de la cuenca a un área determinada. 

Demostrando también que la mayor vulnerabilidad en la cuenca Ilo 

Moquegua se da en el escenario de niña moderada BCA obteniendo una 

vulnerabilidad medio alta producto de la mala regulación de la cuenca y las 

condiciones climáticas de cada uno de los escenarios, luego del análisis de cada 

uno de los indicadores de cada dimensión señalada. Según (INGEMMET, 2019, p. 

166) señala que la vulnerabilidad de nivel alto en la cuenca hidrografica Ilo – 

Moquegua se delimita a nivel de las caracteristicas del relive que se presenta en la 

cuenca, ante posibles fuentes de contaminacion, que hace a la cuenca mas 

sensible a este tipo de afeccion medio ambiental. 

 



83 

 

VI. CONCLUSIONES 

▪ Se determinó la vulnerabilidad de la cuenca en diferentes escenarios del 

cambio climático y se demostró que la mayor vulnerabilidad en la cuenca 

Ilo - Moquegua se da en el evento de la niña moderada BCA obteniendo 

una vulnerabilidad medio alta producto de la mala regulación de la cuenca 

y las condiciones climáticas de cada uno de los escenarios analizo según 

los indicadores de cada dimensión tomada en cuenta, demostrando que 

la gestión de la vulnerabilidad de la cuenca Ilo Moquegua puede reducirse 

si se llega a realizar, ya que esta cuenca solo presenta 1 escenario 

vulnerable medio alto de cambio climático. 

▪ Se identificó la situación actual de la cuenca, sus parámetros 

morfométricos, y sus dimensiones, biofísica, sociocultural, político 

institucional y económico productivo, de acuerdo a lo obtenido se aprecia 

que se aprecia que la cuenca posee con respecto a su dimensión 

biofísica, tiene un índice con capacidad de retención moderada, la 

cobertura vegetal predominante es de tipo desértica, el índice de uso de 

agua es regular, pues no toda la población tiene acceso al agua potable, 

su fragmentación es fuerte, la calidad de agua es media, la precipitación 

es muy baja y las temperaturas son no muy variables, el caudal es bajo, 

en la dimensión político institucional las inversiones son buenas y se dan 

pero los proyectos no se terminan, la cuenca tiene 15 actores,  en la 

dimensión económico productiva, el porcentaje de cobertura acueducto 

rural y urbano el abastecimiento del agua es muy bueno ya que logra 

abastecer a más del 90% de la cuenca, Y respecto a la dimensión socio 

cultural se tiene que la densidad rural es 1.46 hab/km2 y la urbana 9.65 

hab/km2 satisfaciendo los datos estadísticos, la percepción de eficiencia 

del servicio de acueducto usuarios zona urbana satisface a la mayoría y 

en la zona rural es menor al 59%. 

▪ Se procesó los datos obtenidos de las diferentes fuentes como el 

SENAMHI de la temperatura, precipitación y caudal, respecto a las 

precipitaciones en la cuenca son bajas, esto indicaría que la cuenca sufre 
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de sequías, si bien es cierto la construcción del Embalse Pasto Grande 

permite a la cuenca reducir el número de sequías, sería necesario contar 

con infraestructura más especializada para su control, gracias a esta 

estructura la cuenca no presenta un déficit de caudal, sin embargo es 

necesario hacer regulaciones mucho más especializadas. 

▪ Se determinaron 4 dimensiones que inciden en la cuenca hidrográfica Ilo 

– Moquegua en los diferentes escenarios del cambio climático, las cuales 

son: Dimensión Biofísica que considera los indicadores de Índice de 

regulación hídrica, coberturas reguladoras del ciclo hidrológico, índice de 

uso del agua, índice de fragmentación, índice de calidad de agua, 

precipitación, caudal y temperatura; Dimensión político institucional con 

los indicadores de inversiones del acueducto en gestión ambiental para 

la cuenca, actores relacionados con el recurso hídrico en la cuenca; 

Dimensión económico productivo con los indicadores de % de cobertura 

acueducto rural y urbano y Dimensión Socio cultural con los indicadores 

densidad poblacional rural y urbana, percepción de eficiencia del servicio 

de acueducto usuarios zona urbana y percepción de eficiencia del 

recurso hídrico por usuarios zona rural. 

▪ Se realizó una propuesta de estrategias para hacer frente a los efectos 

del cambio climático para la cuenca hidrográfica Ilo - Moquegua, esta 

permitirá una mejor toma de decisiones de carácter político para mejorar 

su manejo y prevenir los efectos provocados por el cambio climático. 

  



85 

 

VII. RECOMENDACIONES 

 

• Es urgente establecer una institución a nivel de cuenca que se ocupe del 

diseño y aplicación de las políticas de nivel público a través del 

establecimiento de estrategias frente al cambio climático. 

● Es necesario tener personal capacitado para el establecimiento de 

estrategias de mitigación y adaptación al cambio climático, además de contar 

con el apoyo de las autoridades regionales y locales en conjunto con todos 

los actores en la Cuenca Moquegua ya identificados. 

● Es importante señalar que a través de este tipo de trabajos se podrá brindar 

herramientas que permitan una mejor toma de decisiones políticas, así como 

una mejor gestión de la cuenca, ya que la mejor manera de hacerlo es por 

medio de la participación. 

● Como ya se observó, la cuenca presenta déficit hídrico, por lo que se 

recomienda implementar medidas como la recarga artificial de acuíferos, y 

mejorar el almacenamiento de aguas, esto permitiría incrementar la 

disponibilidad de agua y mejorar su calidad, estas técnicas, así como otras 

permitirán que la cuenca no sea dependiente de otras como la cuenca del 

rio Tambo, pero esto requiere un mayor análisis profesional. 
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ANEXOS 

ANEXO N° 01  

MATRIZ DE CONSISTENCIA 

 

Título: Gestión de la Vulnerabilidad de la Cuenca Hidrográfica Ilo - Moquegua frente a Diferentes Escenarios del Cambio Climático 
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Fuente: Elaboración propia. 



Anexo N° 02  

Procedimiento de delimitación de la cuenca en ArcGIS 

Descarga de imágenes DEM: Para la delimitación de nuestras cuencas es 

indispensable la utilización de imágenes DEM, las cuales han sido descargadas de 

los siguientes enlaces y la descarga de cada DEM se detalla en el diagrama de flujo 

DEM. 

Sitios Web utilizados: 

● https://earthexplorer.usgs.gov/ 

● http://geoservidorperu.minam.gob.pe/geoservidor/download_raster.aspx 

Proceso de delimitación:  

Definir proyección del DEM: Es necesario que el archivo ráster cuente con 

una proyección, en caso de no contar se la puede definir desde la caja de 

herramientas ArcToolbox, se define la proyección tanto en el sistema de 

coordenadas entrante (en caso de no tener) como el de salida. 

 

 

ArcToolbox > Data Management Tools > Projections and Transformations > 

Raster > Project Raster 

https://earthexplorer.usgs.gov/
http://geoservidorperu.minam.gob.pe/geoservidor/download_raster.aspx


 

 

Figura 23. Archivo Raster 

 

Fuente: ArcGIS 10.4.1 

Eliminar imperfecciones del DEM: Una vez definida la proyección 

usaremos la herramienta Fill, que permite rellenar vacíos en la superficie del ráster 

para quitar imperfecciones en la información del DEM, tan solo es necesario 

trabajar con el DEM generado en el paso anterior. 

 

 

ArcToolbox > Spatial Analyst Tools > Hydrology > Fill 



 

 

Figura 24. DEM sin imperfecciones 

 

Fuente: ArcGIS 10.4.1 

Definir la dirección de la red hídrica: Por medio de la herramienta Flow 

Direction, crea un ráster con la dirección de flujo de cada una de sus celdas hasta 

su vecina cuesta abajo, aquí seleccionamos el ráster generado con Fill. 

 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction 



 

 

Figura 25. Flow direction 

 

Fuente: ArcGIS 10.4.1 

Determinar la acumulación la red hídrica: Ahora con la herramienta Flow 

Accumulation, se crea un ráster del flujo acumulado para cada una de sus celdas, 

también se puede aplicar un factor de peso si es necesario, la entrada de esta 

herramienta es el archivo ráster generado con la herramienta Flow Direction. 

 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation 



 

 

Figura 26. Flow Accumulation 

 

Fuente: ArcGIS 10.4.1 

Delimitar automáticamente la cuenca hidrográfica: Se utilizan las 

siguientes herramientas: 

Basin, elabora un ráster delineando todas las cuencas hidrográficas en base 

a la red de drenaje, el ráster de entrada es el creado con la herramienta Flow 

Direction. 

 

Como siguiente paso este transforma el ráster que se generó con Basin a 

vector (shapefile), con la herramienta Raster to Polygon. 

 

Recortar la cuenca hidrográfica, aquí solo basta con usar la herramienta 

clip de Geoprocessing, o en su lugar seleccionar la cuenca deseada y exportar 

desde las propiedades (clic derecho sobre el shapefile Export Data). 

ArcToolbox > Spatial Analyst Tools > Hydrology > Basin 

ArcToolbox > Conversion Tools > From Raster > Raster to Polygon 



 

 

 

Figura 27. DEM cortado 

 

Fuente: ArcGIS 10.4.1 

Construir automáticamente la red hídrica: Con la herramienta Raster 

Calculator, al construir la red hídrica primaria se puede determinar los valores del 

raster Flow Accumulation mayores a 1234567, y para la secundaria mayores a 

1234. 

● Red primaria: Flow_accumulation > 1234567 

● Red secundaria: Flow_accumulation > 1234 

 

ArcToolbox > Analysis Tools > Extract > Clip 

ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator 



 

 

Figura 28. Herramienta Raster Calculator 

 

Fuente: ArcGIS 10.4.1 

Ahora que se ha elaborado la red hídrica, convertir el ráster a shapefile con 

la herramienta Raster to Polilyne. 

 

ArcToolbox > Conversion Tools > From Raster > Raster to Polyline 



 

 

Figura 29. Cuenca hídrica 

 

Fuente: ArcGIS 10.4.1 

Extraer la cuenca: Finalmente se procede a recortar los shapefiles de la red 

hídrica (construida anteriormente), con ayuda de la herramienta Clip, tomando 

como entrada la red de polilineas y cortar con el perímetro de la cuenca 

determinada anteriormente (sexto paso). 

 

 

ArcToolbox > Analysis Tools > Extract > Clip 



 

 

Figura 30. Herramienta Clip 

 

Fuente: ArcGIS 10.4.1 

Adicionalmente se puede usar herramientas en la sección Hydrology tales 

como: 

● Zonal Statistics, genera estadísticas del ráster (Para la elaboración de la 

curva hipsométrica). 

● Stream Order, asigna el orden numérico de cada uno de los segmentos del 

ráster que representan las ramas de una red lineal (red hídrica). 

Datos meteorológicos y de precipitación: Los datos meteorológicos y de 

precipitación se extraerán de la base de datos de SENAMHI. 

Enlace web: https://www.senamhi.gob.pe/ 

Datos obtenidos para la curva hipsométrica en ArcGIS 

https://www.senamhi.gob.pe/


 

 

Figura 31. Tabla de atributos para la curva hipsométrica. 

 

Fuente: ArcGIS 10.4.1 



 

 

Figura 32. Diagrama de flujo para extraer el DEM 

 

Fuente: Elaboración propia. 



 

 

Anexo N° 03 

 Validación de instrumento 

 

 



 

 

 

 

 





 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 



 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           

           

           

           

           

           

            



 

 

 



 

 

 



 

 

 

 



 

 

 

 



 

 

 



 

 

 



 

 

 



 

 

 



 

 

 

 



 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 



 

 

 



 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 


